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1 Introduction

1.1 Purpose of this Operating Guide

This manual provides basic knowledge required to use the MCT 10 Set-up Software with Danfoss drives. Familiarity with the following
is assumed:

• MS®-Windows™ at user level.

• Set-up, process knowledge, and operation of drive.

• Use of and linkage with communication equipment.

The manual does not provide any detailed information regarding specific applications or possible solutions and related parameter
combinations in the set-up and use of a drive. Refer to the operating guide and design guide of the drive. Any update of the manual
and instructions related to the MCT 10 Set-up Software is available at www.danfoss.com/en/search/?filter=type%3Adocumentation
%2Csegment%3Adds.

Familiarity with the PC or PLC master of the system is assumed. Issues regarding hardware or software produced by other
manufacturers are beyond the scope of this manual and are not the responsibility of Danfoss.

Refer to the appropriate manuals for more information about master-to-master communication, or communication to a non-Danfoss
slave.

1.2 Manual and Software Version

This manual is regularly reviewed and updated. All suggestions for improvement are welcome.

Edition Remarks Software version

MG10RDxx Upgrade to new software version. Support of VLT® Sensorless Safety MCB 159 added. 4.4X

The original language of this manual is English.

1.3 Intended Use

The MCT 10 Set-up Software enables full system configuration and control. With MCT 10, it is possible to monitor the entire system
more efficiently for faster diagnosis and better preventive maintenance.

MCT 10 is designed as an interactive commissioning tool for quick and easy commissioning of the following drive series:
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• VLT® 2800

• VLT® 4000.

• VLT® 5000.

• VLT® 6000.

• VLT® 8000.

• VLT® Micro Drive FC 51.

• VLT® HVAC Basic Drive FC 101.

• VLT® HVAC Drive FC 102.

• VLT® Refrigeration Drive FC 103.

• VLT® AQUA Drive FC 202.

• VLT® Midi Drive FC 280.

• VLT® AutomationDrive FC 301/FC 302.

• VLT® AutomationDrive FC 360.

• VLT® Decentral Drive FCD 302.

• VLT® DriveMotor FCM Series.

• VLT® Compressor Drive CD 302.

• VLT® Compressor Drive CDS 302.

• VLT® Compressor Drive CDS 303.

• VLT® Soft Starter MCD 500.

• VLT® Soft Starter MCD 600.

• VLT® Advanced Active Filter AAF 006.

Use cases of the MCT 10:

• For planning a new communication network offline. The MCT 10 contains a complete database with all Danfoss Drives products.

• For commissioning drives online.

• For easy replacement of drives.

• For easy expansion of networks with more drives.

• For back-up of parameter settings of drives in a communication network.

• The MCT 10 supports PROFIBUS DP-V1 communication via a master class 2 connection. This connection eliminates the need for an
extra communication network.

The communication framework part of MCT 10 is handling the control of the fieldbusses. It provides enhanced capabilities allowing
multiple concurrent fieldbus communication. Several fieldbusses can be configured and combined in the same network within MCT
10.

N O T I C E
If several fieldbusses are created with the same type, make sure that they are configured with different scan ranges.

1.4 System Requirements

To use the VLT® Motion Control Tool MCT 10, the IBM-compatible computer must meet the following minimum system requirements:
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• A Pentium PIII 350 Mhz or compatible microprocessor.

• 1 GB of RAM recommended.

• A CD-ROM drive.

• 1.4 GB of available space on the hard drive.

MCT 10 runs on the following MS Windows versions:

• Windows™ 7 32/64-bit editions.

• Windows™ 8 32/64-bit editions.

• Windows™ 10 32/64-bit editions.

1.5 Software Modules

The VLT® Motion Control Tool MCT 10 Set-up Software is supplied in 2 modules:

• MCT 10 Set-up Software for:

- Setting the drive parameters.

- Copying parameter sets to and from a drive.

- Documentation/printout of set-up, including diagrams.

- Servicing and fault analysis.

• APoss program for creating APoss programs.

1.5.1 Features of the VLT® Motion Control Tool MCT 10

• Project-oriented PC tool, 1 tool for all drive series.

• Links to all Windows applications possible.

• Supports Siemens CP PCMCIA-and PCI cards for PROFIBUS DP-V1 master class 2 connection.

• Supports standard interfaces: COMx, USB, RS232 (Flux).

• Siemens PG/Field PGs already have the required hardware.

• View is highly individually configurable.

• Downwards compatibility with Dos-Dialog (*.mnu) and WinDialog (*.vlt).

• Windows™ Explorer-like interface for quick and easy start-up and navigation.
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PC (Master)

USB to RS485 converter

#1 #2 #3 #126

Illustration 1: Connect up to 126 Nodes with a Repeater and up to 31 Nodes without Repeater

1.6 Versions

VLT® Motion Control Tool MCT 10 is available in 2 versions:

• MCT 10 Set-up Software Basic is available free of charge. Download the program from www.danfoss.com/en/service-and-support/
downloads/?sort=title_asc&filter=download-type%3Dsoftware%2Csegments%3Ddds

• MCT 10 Set-up Software Advanced can be purchased using ordering number 130B1000.

Table 1: Features of the Basic and Advanced Versions

Version supports MCT 10 Set-up Software
Advanced

MCT 10 Set-up Soft-
ware Basic

Drives per project Unlimited 4

FC protocol ✓ ✓

Functional safety ✓ ✗

USB ✓ ✓

PROFIBUS DP-V1 ✓ ✓

PROFIBUS DP-V1 handling multiple Danfoss nodes concurrently ✓ (limited performance) ✗

Ethernet-TSC ✓ ✓

Logging and scope function 8 channels 2 channels

Real-time logging from a drive 4 channels ✗

Alarm display ✓ View only

VLT® Motion Control Option MCO 305 ✓ ✓
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Version supports MCT 10 Set-up Software
Advanced

MCT 10 Set-up Soft-
ware Basic

Graphical smart logic control ✓ ✓

VLT® 5000 to FC 302, VLT® 6000 to FC 102, and VLT® 2800 to FC 280 conver-
sion wizards

✓ ✓

FC to FC conversion wizard ✓ ✓

Import 3000.XLS to FC 302 ✓ ✗

Motor database ✓ ✗

VLT® Extended Cascade Controller MCO 101 ✓ ✗

Drive file system ✓ ✗

VLT® Wireless Control Panel LCP 103 ✓ ✓

Status plug-in ✓ ✓

Drive plug-in ✓ ✗

VLT® Software Customizer ✓ ✗

1.7 Further Information

The following manuals related to VLT® Motion Control Tool MCT 10 are available:

• VLT® PROFIBUS DP-V1 MCA 101 Installation Guide.

• Design guides for the relevant drives.

Refer to www.danfoss.com/en/about-danfoss/our-businesses/drives/ for more information.

It is also possible to find video training material on this site for operating the MCT 10.
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2 Safety

2.1 Safety Symbols

The following symbols are used in this manual:

D A N G E R
Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

W A R N I N G
Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

C A U T I O N
Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

N O T I C E
Indicates information considered important, but not hazard-related (for example messages relating to property damage).

2.2 Safety Precautions

W A R N I N G
HIGH VOLTAGE

AC drives contain high voltage when connected to AC mains input , DC supply , or load sharing. Failure to perform installation,
start-up, and maintenance by qualified personnel can result in death or serious injury.

- Only qualified personnel must perform installation, start-up, and maintenance.

W A R N I N G
UNINTENDED START

When the drive is connected to the AC mains, DC supply, or load sharing, the motor may start at any time, causing risk of death,
serious injury, and equipment, or property damage. The motor may start by activation of an external switch, a fieldbus
command, an input reference signal from the LCP or LOP, via remote operation using MCT 10 Set-up software, or after a cleared
fault condition.

- Press [Off] on the LCP before programming parameters.

- Disconnect the drive from the mains whenever personal safety considerations make it necessary to avoid unintended
motor start.

- Check that the drive, motor, and any driven equipment is in operational readiness.
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W A R N I N G
DISCHARGE TIME

The drive contains DC-link capacitors, which can remain charged even when the drive is not powered. High voltage can be
present even when the warning indicator lights are off.

Failure to wait the specified time after power has been removed before performing service or repair work could result in death
or serious injury.

- Stop the motor.

- Disconnect AC mains, permanent magnet type motors, and remote DC-link supplies, including battery back-ups, UPS, and
DC-link connections to other drives.

- Wait for the capacitors to discharge fully before performing any service or repair work. The discharge time is specified in the
drive operating guides.

- Use a measuring device to make sure that there is no voltage, before opening the drive or performing any work on the
cables.
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3 Installation and De-installation

3.1 Introduction

The VLT® Motion Control Tool MCT 10 Set-up Software and SyncPos modules are installed via a multilingual, self-explanatory
installation program.

3.1.1 Starting the Installation Program

Procedure

1. Select the submenu Run from File in Windows programming control.

2. Enter: [DRIVELETTER]:\SETUP in the command line and press <Return>.

3. Follow the instructions of the installation program.

When the installation process is complete, the MCT 10 Set-up Software can be found on the following path:
e3

0b
t5

14
.1

2

Illustration 2: Path for MCT 10 Set-up Software

3.1.2 Selecting the Software Language

Context:

The Danfoss default language is English. If another language is selected, it becomes the new default.
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Procedure

1. Select Options from the main menu, then select Language.

2. Select the wanted language from the scrollbar and click OK.

e3
0b

t5
15

.1
2

Illustration 3: Selecting the Language

N O T I C E
Changing the language affects the parameter language. If an external LCP is connected to the drive, the change of
language version does not affect the language in the display.

3.1.3 Uninstalling the Software

Context:

N O T I C E
The following procedure is only valid for Windows operating systems.

Procedure

1. Select Start.

2. Select Settings.

3. Select Control Panel.

4. Double-click Remove/Add Programs.

5. Select Remove.
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4 Set-up of Communication

4.1 Communication Options

Drives in the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, and VLT® AutomationDrive FC 302 series are equipped with a USB port.
Communication from a PC can be established using a standard A–B male-to-male USB cable connected to the drive. No extra hardware
or bus configuration is required. If the PC is equipped with more than 1 USB port, several drives can be connected. The USB bus is
automatically added to the network bus list.

Establish a hardwired connection through:

• Standard built-in RS485, or

• USB port.

The USB interface socket allows devices to be connected and disconnected using hot swapping. When connecting a drive using USB,
MCT 10 Set-up Software automatically adds on to the bus list.

If the VLT® PROFIBUS DP-V1 MCA 101 or the VLT® EtherNet/IP MCA 121 option is mounted in the drive, establish the connection
through:

• PROFIBUS master class 2 connection (MSAC 2), or

• Ethernet-based network.

N O T I C E
Soft starters can only be connected through a USB cable.

N O T I C E
RISK OF DAMAGE TO PC USB HOST CONTROLLER

When connecting the PC to the drive through the USB cable, there is a risk of damaging the PC USB host controller.

- Follow the recommendations for grounding described in the operating guide for the relevant drive.

- Use a USB isolator with galvanic isolation to protect the PC USB host controller from ground potential differences when
connecting the PC to a drive through a USB cable.

- Do NOT use a PC power cable with a ground plug when the PC is connected to the drive through a USB cable.

Communication from a PC can be established via RS232 to RS485 converters or via USB to RS485 converters.
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Illustration 4: Communication from a PC

4.2 Manual Fieldbus Configuration

Context:

After installation, configure the non-plug-and-play networks via the fieldbus configuration dialog.
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Procedure

1. Start the MCT 10 Set-up Software.

2. Select Network.

3. Right-click Network and select Add/Remove/Configure Busses.

e3
0b

t6
22

.1
1

Illustration 5: Refreshing the Fieldbus List

4. Add, remove, or configure the properties for the connected busses.
e3

0b
t6

30
.1

1

Illustration 6: Fieldbus Configuration

5. Scan the network for active drives to make MCT 10 indicate available drives on the non-plug-and-play fieldbusses.

4.3 Automatic Scan

Only the USB fieldbus is scanned automatically when a drive is connected to the PC. For non-plug-and-play fieldbusses, scan manually
for active drives.

4.3.1 Scan Range Configuration

Enter the preferred scan setting by right-clicking SerialCom and then selecting Configure Driver.

Adding a standard bus RS485 or PROFIBUS to the network tree configures the scan range to scan the entire address range. The
Ethernet-TSC bus is added using the current IP address settings.

The fieldbus scan range can be configured in several ways:
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• Right-click the Fieldbus icon in the network tree and select Configure Bus.

• Mark the Fieldbus icon in the network tree and select Configure under Communication in the main menu bar.

• Open the Fieldbus Configuration dialog, right-click the Network icon, and select Add/Remove/Configure Busses.

• Open from the Windows panel.

e3
0b

t4
95

.1
2

Scan network icon

Illustration 7: Scan Network Icon

4.3.2 Scan Network

Scan a fieldbus in 3 ways:

• Right-click the Fieldbus icon in the network tree and select Scan Bus for active drives.

• Mark the Fieldbus icon in the network tree and select Scan/Refresh under Communication in the main menu bar.

• Mark the Fieldbus icon in the network tree and select the Scan icon on the toolbar.

The Scanning for Drives window appears and indicates the progress of the scan.

e3
0b

t4
96

.1
1

Illustration 8: Progress of Network Scanning

N O T I C E
When using VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, and VLT® AutomationDrive FC 302: FC Drive MC Protocol
(parameter 8-30 Protocol set to [1] FC MC) is required for correct functionality. The parameter is only available from the LCP.

4.4 Set Up the Drive with RS485 Data Communication

All drives can be configured to 300, 1200, 4800, 9600 (default), 19200, 38400, 57600, or 115200 baud. The serial configuration is always
configured with:

• 8 data bits.

• 1 stop bit.

• Even parity.
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4.4.1 Configuring the Fieldbus

Context:

When using an RS485 converter as the Advantech ADAM converter, MCT 10 Set-up Software indicates online drives available on the
fieldbus after scanning the bus.

N O T I C E
Protocol and advanced settings are for performance optimization and should normally not be changed.

Procedure

1. Open the Serial Fieldbus Configuration dialog box or right-click the appropriate fieldbus.

e3
0b

t6
29

.1
1

Illustration 9: Serial Fieldbus Configuration

2. Set the COM port number.

When using USB to RS485 converters, the actual COM port number can be identified from the device manager part of the
Windows control panel.

3. Set the baud rate, parity, and the number of stop bits (must match the settings in the drive).

4. Set the fieldbus scanning range to the available address to limit the time scanning for active drives.

5. Press OK to activate settings or select to restore the default settings.
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4.4.2 USB Data Communication

e3
0b

t6
23

.1
1

Illustration 10: Network Bus List

When the USB cable is disconnected, the drive connected via the USB port is removed from the network bus list.

N O T I C E
A USB bus has no address-setting capacity and no bus name to configure. If connecting more than 1 drive through USB, the bus
name is automatically incremented in the MCT 10 network bus list. Connecting more than 1 drive through a USB cable often
causes computers installed with Windows XP to throw an exception and crash. Therefore, it is recommended only to connect 1
drive via USB to the PC.

4.5 Set-up of Soft Starter

Setting up connectivity to the VLT® Soft Starter MCD 500 and VLT® Soft Starter MCD 600 requires that the USB communication module
is mounted on the soft starter. Communication from a PC can be established using a standard A–B male-to-male USB cable connected
to the USB communication module. If the PC is equipped with more than 1 USB port or a USB HUB, several soft starters can be
connected.

4.5.1 Serial Configuration

All soft starters can be configured to 300, 1200, 4800, 9600 (default), 19200, 38400, 57600, or 115200 baud. The serial configuration is
always configured with:

• 8 data bits.

• 1 stop bit.

• No parity.
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Illustration 11: Serial Configuration of Soft Starters

4.5.1.1 Configuring the Fieldbus

Procedure

1. Add and configure the bus from the Fieldbus Configuration dialog.

If the bus is already added to the network, it can be reconfigured by right-clicking on the appropriate soft starter fieldbus.

2. Set the COM port number. The actual COM port number can be identified from the device manager part of the control panel.

3. Set the baud rate, parity, and the number of stop bits (must match the setting in the soft starter).

4. Reset to Default restores the general settings and fieldbus scanning to factory configuration values.

4.5.1.2 Using the Hilscher NetIdent Protocol

Context:

Use the tool for searching for devices and for identifying and changing IP addresses. The tool also has a filtering function.
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Procedure

1. Click the Tools menu.

2. Select Soft Starter Discover and Configuration Tool.
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Illustration 12: Selecting the Hilscher NetIdent Tool

3. Select the soft starter for which the IP address should be configured.

4. Click Configure.

4.5.2 Importing/Exporting Parameter Files, MCD 600

Context:

As the VLT® Soft Starter MCD 600 does not support any fieldbusses, a parameter file (PAR file) is exported from the soft starter to a USB
stick and copied into VLT® Motion Control Tool MCT 10. After changing the file in MCT 10, the PAR file can be copied back to the USB
stick and applied to the soft starter.
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Procedure

1. Create an MCD 600 project soft starter.

2. Right-click the project folder.

3. Select Import parameters.

4. From the dialog, select the file to import.

A dialog opens showing information about the selected file.
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If the soft starter differs from the project, it shows up as an error or warning in this view, depending on the difference.

5. Press Continue to apply the file.

A view, which shows all changed parameters, appears.
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6. Click Ok to close the window.

7. Right-click the project to export from MCT 10.

8. Select the parameters to export.

9. In the file selection dialog, select where to export the file to.
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A dialog appears when the export is completed.
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4.6 PROFIBUS DP-V1 Communication

Setting up PROFIBUS DP-V1 communication requires a VLT® PROFIBUS DP-V1 MCA 101 option module. Communication from a PC
using PROFIBUS DP-V1 can be established using a PROFIBUS PCMCIA card or a card installed in the PC. The PROFIBUS cable from the
drive is connected to the 9-pin sub D socket connector on the card.
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PCMCIA
DP-V1 card

DP-V1

#1 #2 #N

DP-V1

#1 #2 #N

Insertable
DP-V1 card

Illustration 16: PROFIBS DP-V1 Communication

Consult Siemens www.siemens.com for the latest supported cards for PCs.

N O T I C E
Connectivity via PROFIBUS DP-V1 to a VLT® AutomationDrive FC 302 utilizing the VLT® PROFIBUS Converter MCA 114 with
option firmware version 2.03 is not possible from MCT 10 Set-up Software. Use the fieldbus or USB bus instead.

Set-up of CommunicationOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 27Danfoss A/S © 2019.01



4.6.1 Configuring PROFIBUS DP-V1

Context:

When using a PROFIBUS interface card with the associated driver installed, MCT 10 Set-up Software indicates online drives available on
the specific PROFIBUS after scanning the bus for active drives.

Procedure

1. Configure the bus from the Fieldbus Configuration dialog or by right-clicking the appropriate PROFIBUS bus.
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Illustration 17: PROFIBUS Fieldbus Configuration

2. Set the board number.

3. Set the fieldbus scanning range to the available addresses only to limit the time used for scanning active drives.

4. Press OK to activate or reset to restore factory default settings.

4.6.2 DP-V1 Connection and PG/PC Interface

The MCT 10 Set-up Software PROFIBUS DP-V1 fieldbus plug-in utilizes the Siemens SoftNet driver available from Step7, or alternatively
Simatic NET, to establish connectivity via the supported master class 2 cards such as CP5511 or CP5512.

N O T I C E
STEP7 Lite version does not support the SoftNet driver.

4.6.2.1 Setting Up the PG/PC Interface

Context:

This procedure explains how to set up the PG/PC Interface from default configuration to open the PROFIBUS connection from MCT 10.

Prerequisites:

Cabling and terminations must be in accordance with wiring and cabling requirements for PROFIBUS.
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Procedure

1. Open the PG/PC Interface.
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Illustration 18: Set PG/PC Interface

2. Configure Access Point of the Application to CP_L2_1 pointing to the master class 2 card used.

3. Set Interface Parameter Assignment Used corresponding to the master class 2 card used.

4. Select Properties to configure the station- and network parameters.

Station parameters:

• Set PG/PC is the only master on the bus to Active if no PLC is active on the bus. Use the Diagnostics described later to select a valid
PROFIBUS address.

Network parameters:

• Set the Transmission rate to the same baud rate as the PLC if it is active.

5. Use DP as Profile and click OK to close the Properties dialog.

6. Select Diagnostics in the Set PG/PC Interface to verify network- and bus communication.
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Illustration 19: Properties Dialog
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Illustration 20: Simatic Network Diagnostics Dialog

7. Select Test to verify the access path and network configuration. If a sharing violation is detected, the test results in an error
message. When the test result is successful, select Read to identify the active PROFIBUS nodes available on the network. Make sure
that the address defined for the PG/PC interface does not conflict with an active node.

8. Close the PG/PC interface and start MCT 10.

9. Right-click a PROFIBUS and select Scan for active drives. MCT 10 Set-up Software identifies the same node IDs, except PLCs.

4.6.3 PROFIBUS Multitelegrams

With the Parameters allowed per telegram drop-down list, it is possible to configure the number of requests to be associated within a
multitelegram. The standard allows up to 40 telegrams to be associated.

The following options are available:

• Maximum speed (default configuration). Handles the association automatically and adapts the number of telegrams for each drive
according to the series. Can be used in PROFIBUS networks containing both old and new Danfoss drives.

• Conservative. Always associates 10 telegrams within a multitelegram. This option is useful when communicating only with old
products such as the VLT® Decentral Drives FCD 300, VLT® DriveMotor FCM 300, series derived from VLT® HVAC Drive FC 102, VLT®
AQUA Drive FC 202, and VLT® AutomationDrive FC 302.

• Single request. Only 1 request per telegram.

4.7 Ethernet-TSC Data Communication

To set up an Ethernet-TSC (transparent socket channel) communication, the VLT® EtherNet/IP MCA 121 option module is required
within the drive. Communication from a PC can be established using a standard Ethernet cable connected to the drive.
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4.7.1 Ethernet-TSC Configuration

An Ethernet-TSC bus is scanned using DDP (drive discovery protocol). The protocol does not require an IP port number and IP scan
range. It identifies drives based on the MAC addresses.

N O T I C E
When scanning through different subnets or remotely via a VPN tunnel, it is advised not to utilize the ADDP protocol but to use
an IP range.

Click Refresh to generate a list of all active drives in the Ethernet. The list appears in the Ethernet Fieldbus Settings dialog when the scan
is complete.
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Illustration 21: ADDP Configuration

Drive types without any IP configuration use their Auto IP Class B address, which is 169.254.yy.xx, with yy.xx corresponding to the last 2
segments in the MAC address. Several uncommissioned drives without any IP configuration can be scanned on the same network.

Select a device from the Discovered Drives list to;

• Get more information about the device.

• Assign a static IP address, a subnet mask, or default value to the drive.

• Set up DHCP (dynamic host configuration protocol) look-up.
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Illustration 22: TSC Configure

4.7.1.1 Scanning with IP Range

Context:

When scanning using an IP range, the Ethernet telegrams are transmitted as traditional TCP/IP packages routed out in a router, switch,
or manage switch without requiring any changes. The disadvantage is an increased scanning time, and drives without IP address
configured are not identified.

N O T I C E
Identification of drives using the VLT® EtherNet/IP MCA 121 option is possible only from option firmware version 1.03 or newer.
If using options with firmware versions earlier than 1.03, configure parameter 12-89 Transparent Socket Channel Power to 0 to
prevent the option from failing to operate.
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Procedure

1. Configure the IP start address and the transparent socket channel port (parameter 12-89 Transparent Socket Channel Port), which is
factory default 4000 in the drive.

e3
0b

t8
52

.1
1

Illustration 23: Scan Range

After the scan, all active drives are identified.

2. Use a corresponding drive to read or write to a single drive instead of waiting for MCT 10 to scan and identify all drives.

A Open the project file and create offline drives manually.

B Configure the connection properties.

C Right-click the offline drive.

D Read and write to the drive without scanning the bus.

4.7.1.2 Filtering

When using multicast, it is possible to filter a range of IP addresses.

Also, use filtering for boosting scan performance.
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Illustration 24: Filtering

4.7.2 Wink Drive

During a commissioning process of a system containing several drives, it can be time-consuming physically to locate a drive based on
the MCT 10 project. This is especially the case if the drive is not equipped with an LCP.

Through the Ethernet_TSC fieldbus, it is possible via MCT 10 to use a wink function. This function blinks with the MS, NS1, and NS2
LEDs on all Danfoss Ethernet-based fieldbus options.

On the Ethernet-based fieldbus option, the winking is recognized with all 3 LEDs blinking orange with 1-Hz interval. There is no limit to
the number of drives winking and the duration of winking.

4.7.2.1 Start Winking

Context:

N O T I C E
It can take up to 30 s from starting or stopping the winking, until the option responds.
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Procedure

1. Right-click a drive from the Ethernet network.

2. Select Start winking or Stop winking.

e3
0b

t7
84

.1
1

Illustration 25: Start Winking

4.7.3 Advanced

Use the Advanced tab:

• To configure Port Number For Range Scan. The default value is 4000.

• To define the TSC Connection Allocation/Sharing.

The drive has limited simultaneous connections, and with this function it is possible to define if the connections should be released or
not. If selecting Release Idling Connections, the MCT 10 releases unused connections and makes them available to other users in the
network after idle timeout.
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Illustration 26: The Advanced Tab
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5 Parameter Set-up

5.1 Introduction

This chapter explains how to control a drive using the MCT 10 Set-up Software. After starting the MCT 10, the main window looks like
the example shown in illustration 27.
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Illustration 27: MCT 10 Set-up Software Main Window

5.2 User Interface

5.2.1 Display

The MCT 10 Set-up Software has 2 views:

• Left view.

• Right view.

Left view

The left view shows the network view (real, online) and the project view (simulated, offline) of the drive network.

Use the left view to:

• Add or delete folders and elements.

• Store changes into the Project folder.

Store changes made to the real online set-up into the Project folder in the simulated, offline set-up for later use.

For more information on saving data, refer to 6.7.1.1 Saving a Project.

The left view is organized in a tree structure and contents can be expanded or collapsed as required. Click +/- to expand/collapse the
folder.

Right view

The right view shows details of the element highlighted in the left view. In the right view, the elements of the drive network can be
programmed.
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Illustration 28: Details Shown in the Right View

Toolbar

A toolbar shows icons for the most commonly used functions.
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Illustration 29: Toolbar

Activate the toolbar under View in the main menu bar, where the toolbar is tick-marked when it is active. To deactivate the toolbar,
select View⇒Toolbar. Check that the toolbar is no longer tick-marked.

5.2.2 Network and Project Folders

The Network folder gives access to physical devices operating in the field. Use Network to configure the physical drive as with the LCP.
Configuration changes made in the Network folder are therefore saved only in the physical device in the field. The Network folder
contains online data.
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The Project folder contains offline data.

N O T I C E
Changes made in the Network folder are not saved automatically to the Project folder.

Network mode - online

The Network folder contains the drives, low harmonic drives, active filters, and/or soft starters online connected to the PC. Monitor and
change the parameter settings exactly as if operating on the control panel.

Data entered online is stored in the drive, low harmonic drive, active filter, or soft starter only, not on the hard disk. For information on
saving data to the hard disk, refer to 6.7.1.1 Saving a Project.

Project mode - offline

The Project folder contains the user-defined network of drive, low harmonic drive, active filter, and/or soft starter.

Data entered offline is stored on hard disk.

Use the Project folder to:

• Open a project file.

• Insert folders.

• Store project-related files in any format, for example Word or PDF.

5.2.3 Other Folders

Four folder types are available for organizing a large system into several smaller systems.

Table 2: Available Folder Types

Name Purpose Icon

Folder Organize drive and/or soft starters
that are part of a machine or sys-
tem.
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File fold-
er

Organize files belonging to a
project. Any file format can be
used.
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Parame-
ter folder

Store parameter settings tempora-
rily or for documentation purposes.
The folder can contain a single pa-
rameter, subgroup, parameter
group, or the entire parameter da-
tabase.
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Name Purpose Icon

Scope
folder

Analyze the behavior of 1 or sever-
al parameters for diagnostic purpo-
ses by visualizing them as a curve.
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Insert any folder type in an offline project in 1 of 2 ways:

• Right-click the project or an existing folder and select New Folder/New File Folder, as shown in illustration 34.

• Alternatively, mark the project or an existing folder and select New Folder/New File Folder under Insert in the main menu bar.
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Illustration 34: Inserting a Folder Type

5.3 Setting Up Drives and Folders

Sometimes, it is necessary to insert a new folder before setting up new drives. See 5.3.1 Inserting a New Folder for instructions.

The way to set up drives depends on the drive type. The methods are described in 5.3.2 Setting Up Drives, Active Filters, or Soft Starters
and 5.3.3 Setting Up Low Harmonic Drives.

5.3.1 Inserting a New Folder

Procedure

1. Right-click the Project folder or selectInsert in the main menu bar.

2. Select New.

3. Select Folder or File Folder.
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5.3.2 Setting Up Drives, Active Filters, or Soft Starters

Context:

Insert the drive, the active filter, or the soft starter in a project folder as follows:

Procedure

1. Right-click in the left view or click Insert in the main menu bar.

2. Select New.

3. Select the appropriate device type.

Inserting a drive opens the New Drive window.
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Illustration 35: New Drive Window

The New Drive window consists of 4 main sections:

Name Enter a unique name for the drive. Any text/number combination is allowed. Also specify with software
version and the voltage in this section.

Select Drive Type Information about the drive series and power size. A PUD file (power unit data information) is also
available. The default file is always preselected.

Options Various information about the installed options.

Connection The fieldbus used between the PC and the drive associated with the address to communicate. The
specific fieldbus type is available from the drop-down menu.

It is mandatory to fill in all fields. The different selections are available from the drop-down menus.
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Once the new drive is added to the Project folder, the drive data is stored in the offline Project folder. To view the data, click the
drive icon.
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Illustration 36: View the Drive Data

To change the stored drive data, right-click the specific drive icon and select Properties.

5.3.3 Setting Up Low Harmonic Drives

Context:

Insert a low harmonic drive in a project folder as follows:
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Procedure

1. Right-click in the left view or select Insert in the main menu bar.

2. Select New.

3. Select Drive.

4. Enter all relevant data in the New Drive dialog and click Make LHD.
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Illustration 37: Entering Data for a New Low Harmonic Drive

N O T I C E
The Make LHD option is only available when power size and voltage ranges of the drive correspond to the supported low
harmonic drive.

5. Enter all active filter data in the New filter dialog. Ensure that the fieldbus address used for the active filter is not used for other
components.

The low harmonic drive is visible in the project as a composition of the drive and the active filter.
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Illustration 38: Low Harmonic Drive Shown in the Project Folder

5.3.4 All Parameters Folders

A new Drive folder contains an All Parameters folder. This folder comprises a series of subfolders with generic names. There is no
rename function for these folders. The generic folders within most drives consist of the following subfolders:

• Operation and display.

• Load and motor.

• References and limits.

• Inputs and outputs.

• Special functions.

• Serial communication.

• Technical functions.

The generic folders can vary according to the type of drive selected.
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Illustration 39: Subfolders in the All Parameters Folder

The generic folders comprise parameters relevant to the drive type selected.
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Illustration 40: Data Example in a Generic Folder

5.3.5 Array Parameters

Parameters containing array data are shown as a matrix in the right view, where the rows of the matrix are defined as ID.1, ID.2, and so
on. For example, array parameters parameter 9-15 PCD Write Configuration and parameter 9-16 PCD Read Configuration are shown over
several entries as 915.1, 915.2, 915.3, and 916.1, 916.2, 916.3 in the right view.
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Illustration 41: Array Parameters
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5.3.6 Sorting

The Danfoss products listed under Network or Project can be sorted according to:

• Folder name.

• Series.

• Software version.

• Address (communication address).

• Power size.

• Voltage.

Click the sorting bar and select the relevant sorting option.
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Illustration 42: Sorting Options

5.4 Customized Views

Select View in the main menu bar to see the display options. The following options are available:

• Show or hide the toolbar.

• Show or hide the status bar.

• Large icons/small icons view.

• View as list of folders and elements.

• View with details of network and project elements.
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Illustration 43: The View Menu

5.4.1 Customize Parameter View Settings

Context:

Apply the selected parameter view settings to subfolders, to an entire project, or to the entire application, that is all MCT 10 Set-up
Software folders in network or project mode.

Procedure

1. Right-click the parameter cell or set-up column.

2. Select Apply Parameter View Settings.
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Illustration 44: Applying Parameter View Settings

3. Select the relevant option and click OK.
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5.4.2 Customize Background Color

Context:

To customize the background color of the views, go to Options⇒Online Parameter Grid Settings.
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Illustration 45: Customizing Background Color

Procedure

1. Select Restore Default to restore factory default background color for online environment.

2. Click […] to open a standard true color picker.

3. Select Add to Custom Colors for customizing colors for later usage.

5.4.3 Customize Parameter View

Context:

The parameters shown in the right view are presented in a series of columns, containing ID, parameter name, 4 set-ups, units, and
factory set-up.

Select Parameter view⇒Set-up⇒Remove Menu.

N O T I C E
Changes made to the removed set-up are still stored in the MCT 10 Set-up Software and can be shown by selecting Customize
Columns.

Parameter Set-upOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 49Danfoss A/S © 2019.01



Procedure

1. Right-click a column.

2. Select Customize Columns.

3. In the left view of the Customize Columns dialog, select the field to be added or removed.
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Illustration 46: Customize Columns Dialog

4. Click either Add or Remove.

5. Change the order of the fields in the right view by clicking Move Up or Move Down.

6. Right-click a column and select Apply Parameter View Settings.
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Illustration 47: Apply Parameter View Settings

7. Select if the settings should apply to the subfolders, the entire project, or the entire application.

5.4.4 Filtering Parameters

Context:

Filter the parameters in the right view according to the following settings:
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Table 3: Available Filter Settings

Setting Description

Read only Only read-only parameters are shown.

Read & Write Only read & write parameters are shown.

Changed parameters Only parameters that have been changed in the current session are shown.

All All parameter groups are shown.

Group One or more parameter groups are shown according to selection.

Procedure

1. Right-click any column in the right view.

2. Select the appropriate filtering setting or the appropriate filtering group.
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Illustration 48: Filtering Columns
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5.4.5 Customize Columns

Procedure

1. Right-click any column.

2. Select Customize Columns.
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Illustration 49: Customize Columns Menu

3. Highlight a field to change the order.

Parameter Set-upOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R046652 | Danfoss A/S © 2019.01



e3
0b

t5
30

.1
1

Illustration 50: Change Order of Fields

4. Select Move Up, Move Down, or Remove.

Removed columns are still stored in the memory and can be retrieved into the right view by highlighting the relevant field name
and selecting Add.

5.5 Parameter Edit

The parameter structures in the MCT 10 and in the drive are the same. Modify the parameter by double-clicking the relevant parameter
entry. If an entry cell is shaded, the parameter is read-only and cannot be modified.
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Shaded cells indicate read-only parameters

Illustration 51: Editing Parameters

Change parameter set-up by manually entering new values in the cells in the right view. Alternatively, change the parameter set-up by
importing values from an active drive using the Read From Drive function.

If a parameter value is set to an illegal value, an error is shown. Parameters can be edited in 2 different modes:

• Inline.

• Dialog-based.
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Illustration 52: Edit Parameter View

Inline edit

In inline edit mode, the available setting options are shown without any detailed descriptions of the options. Inline edit is only
recommended for experienced users.

Dialog-based edit

To have details of parameters available while editing, use dialog-based edit. The parameter details are:

• Parameter options.

• Ranges.

• Functions.

Enter dialog-based edit by deselecting inline edit.

5.6 Comparison of Parameters

Context:

Parameter settings can be compared to the parameter settings in another drive. Comparisons can be made either to another drive
inside the project or to an online drive. The comparison function evaluates whether settings inside the drive have been changed, or
checks if 2 or more drives have the same settings.
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Procedure

1. Activate the function by highlighting the base drive for comparison and select Compare.
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Illustration 53: Comparison

2. Select the drive to compare with.

This drive can be an online drive from the network, or it can be a drive in the offline folder (Project folder).

The result of a comparison can be stored in an ASCII text file for documentation or for subsequent import into a spreadsheet.

It is possible to compare all set-ups, or to compare 1 set-up to another.
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Illustration 54: Comparison Result

5.7 View Change Log

When configuring a drive, active filter, or soft starter from the project, it is possible to view the change log containing the changes
made by the user only, or the changes made including the dependent parameters.
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User-defined changes can be read out by right-clicking All Parameters and selecting Minimal Changeset.
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Illustration 55: Minimal Changeset

Changes made including the dependent parameters can be read out by right-clicking All Parameters and selecting Compare parameters
with default values.
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Illustration 56: Compare Parameters with Default Values

5.8 Read Drive Operation Status

The drive can be in 2 different operating conditions:

• Auto On

• Off
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The operation status can be monitored via the LCP or MCT 10. Use MCT 10 to monitor the actual operation status by clicking a drive
located in the network. Select Refresh Status to update the status information. Parameters can only be written to drives in operation
status Off.
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6 Operation

6.1 Reading and Writing Parameters

Parameter settings can be read from or written to an online connected drive.

Most parameters are read/write and can thus be configured. Other parameters are read-only and cannot be configured. Use the filter
function to view which parameters are read/write or read-only.

Select the values to be read/written and then select the Read From Drive or Write To Drive menu.

The following options are available:

• A single parameter in the right view.

• All parameters in the left view.

• A parameter group in the left view, for example the Load and Motor group.

The read-from-drive and write-to-drive functions apply to the whole section.

Select Options in the menu bar to access a range of functions.
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Illustration 57: Select Options

6.1.1 Read From Drive Settings

Select the required options for reading from an active drive.

Set-ups

Select to read visible set-ups only or to read all set-ups.
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Drive differences

If field device software and MCT 10 Set-up Software versions are not identical, specify the acceptable level of compatibility errors.

Select Allow drive differences to ignore all compatibility errors.

Select Allow drive version difference to restrict the acceptable compatibility errors to those occurring in different software versions but
same drive series. Select Do not allow drive differences not to accept differences between online devices and offline devices.

Save as default settings

Activate Read From Drive settings for all reads from the drive.
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Illustration 58: Read from Drive Settings

6.1.2 Write to Drive Settings

Select the required options for writing to an active drive, which then becomes applicable for all writing to drives.
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Illustration 59: Write to Drive Settings

Write option

By default, Write All Parameters is selected. This means that all read and write parameters are written to online drives.

If selecting Write Changed Parameters, only the subset of parameters different from default are written. This selection improves
performance.

6.1.3 Communication Fault Tolerance

Set an acceptable number of communication faults before disconnecting. The default number of failures is 1000.
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Illustration 60: Fault Tolerance

6.2 Connection Properties

To read or write between online and offline drives, configure the connection properties in the offline project. If the fieldbus does not
refer to an available drive in the network tree, MCT 10 Set-up Software is not able to identify the online drive.

Reconfigure the fieldbus by right-clicking the offline project and select Properties⇒Connection.

Configure the fieldbusses added to the network tree in the Fieldbus drop-down list.
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6.3 Read from Drive

Values can be read from an active drive by right-clicking a selection and then selecting Read from drive.
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Illustration 61: Read from Drive

Once Read from drive is selected, the software accesses the online device and shows the Drives Check window. This window contains a
list of drives with detected compatibility issues.
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Illustration 62: Drives Check Window

Select Details to view details on the different properties between project device (based on database information) and online device
(the connected drive).
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Illustration 63: Details

The color codes indicate the level of compatibility between the project drive and the connected drive for each property.

To continue the reading process, define an action in the Drives Check dialog. The default action is Continue. Other available selections
are:

• Skip the drive.

• None.

• Update project and continue.

The same action can be applied to all devices at a time instead of 1 by 1.

If selecting Skip the drive, MCT 10 Set-up Software does not read that particular device, but continues reading the other devices.

Continue resumes reading. Acknowledge and accept any differences found.

Update project and continue activates the read-from-drive process, and it deletes the data in the project drive and replaces it with data
from the connected drive.

N O T I C E
The Update from connected selection deletes and replaces all information stored in the project drive. To retain the information
entered into the project drive, select Continue.

Once the read-from-drive process is completed, the display shows details of both the Connected Drive Information and the Database
Information.
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Illustration 64: Read-from-drive Process Completed

6.3.1 Changing the PROFINET Host Name

Context:

As of MCT 10 version 4.3, the domain name and host name can be changed via the Read-from-drive Process Completed dialog.
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Procedure

1. Click Change domain or host name.
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A dialog for entering the domain name and host name opens.
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The values entered in the dialog are written to parameter 12-07 Domain Name and parameter 12-08 Host Name.
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6.4 Write to Drive

Procedure

1. Right-click a parameter column title in the right view or click Communication in the main menu bar.

2. Select Write to drive.
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Illustration 67: Write to Drive

6.5 Poll

When in network mode, MCT 10 Set-up Software automatically polls the parameters in the right view to update their status
continuously to reflect live operation.

6.5.1 Stop Polling

Context:

To stop polling, for example to freeze and analyze a particular moment:

Procedure

1. Click Communication in the main menu bar.

2. Select Stop polling.

Alternatively, click the Stop polling icon in the toolbar.
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Stop polling icon

Illustration 68: Stop Polling Icon
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6.5.2 Resume Polling

Procedure

1. Click Communication in the main menu bar.

2. Click Resume polling.

Alternatively, click the Resume polling icon in the toolbar.
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Illustration 69: Resume Polling Icon

6.5.3 Using Smart Polling (Intelligent Scan Frequency)

Context:

While the MCT 10 Set-up Software is polling the parameter grid, the LCP becomes slow. To improve LCP usability, configure MCT 10 to
enable smart polling. Enabling smart polling slows down the polling when the LCP is connected.
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Procedure

1. Click Options in the main menu bar.

2. Select Online Parameter Grid Settings.
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Illustration 70: Selecting Online Parameter Grid Settings

3. Tick the checkbox Enable Smart Polling (slow down the polling when the LCP is connected).
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Illustration 71: Ticking the Checkbox
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6.6 Changing the Set-up of a Field Device

Procedure

1. Open the Network folder.

2. Select the relevant device.

3. Select Stop on the toolbar to stop polling.

4. Change the settings in the set-up columns in the right view.

The changes are implemented online in the field device, but are not recorded.

6.7 Save Changes to a Hard Disk

6.7.1 Recoding Online Changes

Procedure

1. Select the relevant device in the Network folder.

2. Right-click the device and select Copy.

3. Select the Project folder.

4. Right-click and select Paste.

5. Select File from the main menu bar.

6. Select Save As.

7. Save the device file into a directory in the storage location.

6.7.1.1 Saving a Project

Procedure

1. Click File in the main menu bar.

2. Select Save.

Alternatively, click the Save icon in the toolbar.

6.7.1.1.1 Including Drive Information

It is not possible to open a project file including a firmware version not supported by MCT 10 Set-up Software. Including the drive
information in the project file makes it possible to open in other installations with MCT 10 without having the firmware installed.

By opening the project file, the drive information is updated similarly to:

• Selecting Update Drive Support under Tools in the main menu bar.

• Downloading the drive information from an online drive.

The drive information is saved in the project file.
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6.7.1.1.2 Excluding Drive Information

Procedure

1. Click Options in the main menu bar.

2. Select Project properties.

3. Click Store related technical data files into project.
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Illustration 72: Save Drive Information

6.7.2 Archive/Unarchive

Projects that include links to other documents can store the linked files.

By selecting the Archive function, the MCT 10 Set-up Software generates a file that contains all drives and the linked files into a *.ssa file.
If this file is sent to other computers, the user gets a copy of the linked files on the computer.

6.8 Import of Older Dialog Files

For users working with VLT set-up software dialog, the files generated with these software packages can be imported into the MCT 10
Set-up Software.

Files from DOS versions and Windows versions can be imported to the MCT 10 Set-up Software. Following a successful import, the MCT
10 places the imported files in an imported files folder.
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Illustration 73: Import Older Dialogs

Due to limitations in some of the former PC tools, some functionalities cannot be imported, for example, functions such as showing
changed values only.

6.9 Printing

There are 2 print options in MCT 10 Set-up Software:

• Print project.

• Print selected folders.

Both options are in the File menu in the main menu bar. Alternatively, right-click the Project icon and select Print project.

To print a folder, right-click a folder icon within the project and select Print selected folders.

Select Print project to print parameter settings for an entire project. Select Print selected folders to print parameter settings for part of a
project.

OperationOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 71Danfoss A/S © 2019.01



e3
0b

t6
71

.1
2

Illustration 74: Print Options

Select the desired print language from the drop-down list.

Changed parameters

Print either parameters that have been changed from factory default or all parameters.

Options

Select which set-up to print.

More

Click More to be able to print selected parameter groups only.
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Illustration 75: Example of Print Selection

6.10 Update Database Information

If the MCT 10 Set-up Software database information is outdated, updates are available either by download from the Internet or, when
this is not possible, by reading from the drive itself.

When the MCT 10 Set-up Software database for a drive is outdated, the drive icon is shown with a red line through it and the Database
information fields show the message Not supported.
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Illustration 76: Outdated Software Database

Update the database either by right-clicking the drive icon and selecting Download drive info, or by clicking Download drive info.
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Illustration 77: Database Update

To start reading from the drive, select Yes.

When reading from the drive is complete, the drive icon no longer has a red line through it, and the Database information shows
settings identical to the Connected drive information.

Also, the parameter settings are shown in capital letters.

6.11 Update Drives Firmware Support in MCT 10 Set-up Software

The MCT 10 Set-up Software can be updated regardless of the firmware of the drive.

Download upgrades from the Danfoss website www.danfoss.com/en/service-and-support/downloads/?
sort=title_asc&filter=download-type%3Dsoftware%2Csegments%3Ddds and store them on a local disk drive.
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Illustration 78: Update MCT 10 Set-up Software

N O T I C E
The update files can be installed without administrator rights in Microsoft operating systems.

6.12 Software Compatibility

The MCT 10 Set-up Software project files can open legacy version project files.

Table 4: Opening Legacy Versions

Software versions of MCT 10 Set-up Software and drive in existing
project file

Software versions of Danfoss Set-up
Software

Compatible ✓/✗

2.00 and 2.01 2.02 ✓

2.02 and 2.51 2.00 ✗

When MCT 10 Set-up Software has been updated, project files saved with a newer firmware version can be opened and used. Refer to
illustration 79 for an example.
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Illustration 79: Use Updated MCT 10 Set-up Software

6.12.1 Mapping to Compatible Firmware

Context:

To establish connectivity to a drive with firmware version 1.10, it is required to modify the MCT 10 Set-up Software drive database
mapping to firmware version 1.05 as reference.
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Procedure

1. Start the MS Explorer and open the path C:\Program Files\Common Files\Danfoss Drives\SharedSource\.

2. Open the text file ss_version_mapping.txt in Notepad by right-clicking the file and selecting Edit.

3. Change "Series="FC-202",AOC="01.10",Database="01.10" to Series="FC-202",AOC="01.10",Database="01.03".

4. Save and close the file.

To find out if the MCT 10 Set-up Software has been updated, check the information in the About box. This box shows the actual
MCT 10 Set-up Software version.

N O T I C E
System information can be copied directly to the Windows clipboard.
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Illustration 80: Copy System Information

6.13 Conversion Wizard

6.13.1 Conversion

It is required that database versions, power size, voltage range, and option configuration of the source match the destination drive.
Differences can be converted using 1 of the conversion wizards available in the MCT 10 Set-up Software:

• VLT to FC series conversion.

• FC to FC series conversion.
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N O T I C E
If the parameter database of a source drive is different from the database on the destination drive, it cannot be written without
errors signaled during write to drive.

6.13.2 VLT to FC Series Converter Function

It is possible to convert, for example, a VLT® 5000 drive to a VLT® AutomationDrive FC 302 via the conversion matrix in the MCT 10 Set-
up Software.

Read conversion

Excel sheet template       MCT 10
Set-up Software

Write settings

Read settings

VLT 5000
FC 302
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Illustration 81: Conversion

6.13.2.1 Converting Multiple Drives

Procedure

1. Select the Tools menu and activate Drive Conversion Wizard.

2. In the subsequent dialogs, select the drives for conversion.

When converted, a new VLT® AutomationDrive FC 302 drive is created in the Project folder.
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Illustration 82: Conversion of Multiple Drives

6.13.2.2 Import Drive from Excel

Use this function to create a VLT® AutomatonDrive project based on an Excel sheet. For example, import of VLT® 3000 settings from an
Excel sheet into a new FC 302.

An example file is attached in the MCT 10 Set-up Software (vlt3000conversion.xls). This example file can be edited and used for
converting from VLT® 3000 to FC 302.

N O T I C E
Detailed knowledge of Microsoft Excel formula editing is required.

6.13.3 FC to FC Conversion

The converter tool can convert projects within the same drive series, regardless of software versions, power size, voltage range, and
option configuration. It covers:

• VLT® HVAC Drive FC 102.

• VLT® Refrigeration Drive FC 103.

• VLT® AQUA Drive FC 202.

• VLT® AutomationDrive FC 301/FC 302.

• VLT® Lift Drive LD 302.

• All OEM versions based on the FC xxx series.

Differences can be matched by using the Conversion Tables Manager.

A conversion table enables conversion from:

• Online to online drive.

• Online to offline drive.

• Offline to online drive.

• Offline to offline drive.

Two user profiles are available:

• Administrator - qualifies and manages the conversion tables through access to the Conversion Tables Manager. From the
Conversion Tables Manager, new conversion tables can be created and deployed to other MCT 10 Set-up Software installations.

• User - writes projects to the destination using the conversion tables transparently. The user cannot access the Conversion Tables
Manager. Conversion tables can be imported to the database.
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MCT 10 Set-up Software is installed with user rights. Enabling the Conversion Tables Manager is done from the checkbox in the
Converter Tool Settings dialog.
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Illustration 83: Enabling Conversion Table Manager

The conversion tables are stored locally on the hard disk. Using the database non-distributed, the path to the network location can be
reconfigured from the Converter Tool Settings dialog.

6.13.4 Conversion Tables Manager

Access the Conversion Tables Manager via the Tools menu in the MCT 10 Set-up Software.
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Illustration 84: Conversion Tables Manager

A dialog is divided into the following sections:

• A conversion table containing the list of conversion tables in the database.

• A preview pane.

OperationOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 81Danfoss A/S © 2019.01



Conversion tables can be created or imported, edited, exported, or deleted.

Exporting tables

Distribute to other MCT 10 Set-up Software installations by exporting the relevant tables to a *.cvt file. The preview pane lists the
conversion table source and destination drive information.

The conversion can be as follows:

• Drive series based on the FC 102/FC 202/FC 3xx platform.

• Software version (major and minor).

• Power size.

• Voltage range.

• Option A.

• Option B.

• Option C0.

• Option C1.

Create conversion tables

To create a conversion table, open the Conversion Tables Manager or right-click the source drive and select Convert drive.

N O T I C E
When using the right-click option, it is only possible to configure the information of the destination drive. Furthermore,
parameter group 19-** User-defined Parameters is not converted. These settings are configured when writing from source to
destination.
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Illustration 85: Drive Conversion

Editing tables

In the Drive conversion view, enter the information for source and destination drives. Click OK to open the conversion table editor
listing the parameter database differences.

Use the conversion table editor to create or load a conversion table. Ensure that the conversion table matches the drive series, software
version, power size, voltage range, and option configuration. The MCT 10 Set-up Software is not able to find and load incompatible
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conversion tables. After loading or creating the conversion table, it is possible to re-edit the table or to convert the source drive and
store the converted drive in an offline folder.

Formulas

The parameter database is listed and sorted according to the parameter ID. To simplify the conversion process, filter the database to
list alerts or applied changes only.

Table 5: Alert Coding

Color code Description

Red Difference between source database and drive. A formula is required before changes can be applied to the drive.

Blue Difference between source database and drive. The formula is ignored and changes can be applied to the drive.

N O T I C E
If a formula is applied to all alerts, the source parameter database can be converted to the destination parameter database
without any further configuration.
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Illustration 86: Conversion Table

Double-click an alert to open the Formula Editor dialog and specify the destination parameter mapping. The following configurations
are possible:

• Destination parameter is set to default value (factory default value. Default settings for red alerts).

• Destination parameter = source parameter ID.

• Destination parameter = source parameter multiplied by a user-defined numeric value.

• Destination parameter = destination option list or numerical value.

• Ignore this parameter. Default setting for blue alerts.

Each formula applied can be associated with a comment containing a user-defined text. The comment is optional to each alert.
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Illustration 87: Formula Editor

When a formula is applied to all red alerts, assign a name to save the conversion table in the database.

If differences are detected when writing from source to destination drive, MCT 10 Set-up Software uses the following as search criteria:

• The drive series.

• Major software version.

• Power size.

• Voltage range.

• Option configuration.

With the proper conversion table in the database, any drive can be written transparently to a destination even if the minor software
version does not match. If several conversion tables are found matching the criteria, MCT 10 Set-up Software uses the minor software
version to find the closest match. Only 1 drive can be written transparently to the destination.

If parameter group 19-** User-defined Parameters is available, the settings are written transparently to the destination drive.
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6.13.4.1 Converting Offline to Offline/Online to Online

Procedure

1. Mark the appropriate number of set-ups from All Parameters.

2. Right-click and select Copy.

3. Paste the parameters in the destination drive folder.
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Illustration 88: Offline Online Conversion

MCT 10 Set-up Software recognizes any difference and automatically applies a matching conversion table, if available.

6.13.4.2 Converting Online to Offline/Offline to Online

Context:

N O T I C E
Before converting, ensure that offline and online drive connection properties correspond.
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Procedure

1. Right-click the offline drive.

2. Select Read from Drive.
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Illustration 89: Offline Online Conversion

The MCT 10 Set-up Software recognizes any difference and automatically applies a matching conversion table.
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7 Diagnostics

7.1 Alarm, Warning, and Fault Log Readout

Features from version 2.0 support:

• Reading out alarms, warnings, and fault logs of the online drives.

• Quick location of alarms and warnings in the connected drive system.

• Investigation of the fault log for previous trips.

• Gathering and storing events in the project file for later evaluation.

• Sending the project file to a remote specialist for further investigation.

7.2 Localization of Alarms and Warnings

After a complete scanning of a drive network, the MCT 10 Set-up Software indicates if the connected drives have active warnings and
alarms. An exclamation mark in front of the drive icon indicates a warning or an alarm.
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Illustration 90: Drive with Active Alarm or Warning

Expand the drive and click the alarm/warning icon.

Name Icon

Active alarms/warnings
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No active alarms/warning
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Illustration 92: Fault Log View for Control Cards Marked MKI
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Illustration 93: Fault Log View for Control Cards Marked MKII

For a more detailed description of the code, refer to the operating guide for the particular drive. If the drive trips, it stores the cause for
the trip in a fault log buffer. The log consists of 3 values:

• Code.

• Value.

• Time.

When the MCT 10 Set-up Software reads the fault log, it shows the time and date when the log was read.

N O T I C E
The actual time when a fault occurs is not indicated.

7.3 Storing Alarms/Warnings in Project Files

Alarms/warnings and the fault loggings are stored into the Project file. The MCT 10 Set-up Software automatically reads alarms,
warnings, and fault loggings at every read from/write to the drive.

7.4 Handling the Alarms and Warnings Loggings

The MCT 10 Set-up Software allows more than 200 alarms and warnings for each drive in the project. The loggings can be cleared
individually. This is done by entering the loggings to clear and then right-clicking. Clearing the log only clears the PC log while the
information in the drive is unaffected by this handling.

N O T I C E
There are redundant alarm entries in the log.

The MCT 10 Set-up Software stores active alarms and warnings in the Project file at each read/write command. No alarm is lost, but an
alarm can have multiple entries in the log.
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Illustration 94: Loggings

7.5 The Scope Function

The scope function supports monitoring and diagnosing of parameters. The function polls parameter data and dynamically shows the
polled data as a curve graph.

The scope function provides 2 different channel types to sample parameters:

• PC polling channel - Channel selected when the PC SW requests the parameters from the drive. The channel does not have any
time limitation, the buffer size is user-configurable and corresponds to the number of samples. Fast sampling with accurate
sampling rate cannot be obtained because the Windows operating system does not support real-time extension.

• Drive real-time channel - Only available in the FC 102, FC 202, and FC 300 series - uses an internal 16-kByte buffer located in the
drive. Recommended for continuously monitored applications requiring high and precise sampling rates. It is required to set up a
trigger event for the drive to start filling up the buffer with samples.

7.5.1 Activating the Scope - MCT 10 Set-up Software

Insert a new scope from the Insert menu or by right-clicking the Project folder, Drive folder, Regular folder, or Drive.
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Illustration 95: New Scope

Rename the Scope folder via the Edit menu or by right-clicking the icon and select Rename.

The 1st time that the Scope folder is selected, the Add Channel dialog pops up. From this dialog, select the drive to monitor. Then,
depending on the drive series, select the type of channel to collect samples from.
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Illustration 96: Add Channel
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Adding text notes

Insert additional text for later usage to each scope folder such as the type of drive monitored and diagnostic help text. Text notes are
added by right-clicking the Scope folder and selecting New⇒Text note. The default text can be changed by right-clicking the text note
and selecting Rename. Several text notes can be added to the same Scope folder.
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Illustration 97: Text Notes

7.5.2 Configuring the PC Polling Channel

Context:

PC polling channel is enabled by default when a drive is selected within the Network folder or Project folder. All parameters available in
the list are visible by ID name and are automatically updated according to the product.
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Illustration 98: Parameter ID and Name
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Procedure

1. Select a parameter in the parameter list and click Next to update the Add Channel dialog.

2. Configure A/div (value/division).

N O T I C E
MCT 10 Set-up Software stores the values even if they are not shown within the visible area of the curve.
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Illustration 99: Storing Values

3. Define the position number (vertical zero line on the Y axis). If there are several signals on top of each other, it is useful to have
them plotted apart.

4. Set color and tick Marker to differentiate the different curves in a black and white printout. Each curve gets a marker as box,
triangle, cross, and so on.

5. Click OK to generate the curve graph.
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Illustration 100: Generate Curve Graph

6. Right-click the channel box to open the Add Channel dialog and add extra channels.
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Illustration 101: Open Add Channel Dialog

7.5.3 PC Polling Channel Properties

More settings can be configured by right-clicking the Scope window and selecting Properties. It is possible to specify:

• General parameter sample settings.

• Sample trigger settings.

• Cursor settings.

General parameter sample settings

The General tab holds 4 basic settings for the Scope Properties:

• Seconds per division (SEC/DIV).

• Time format.

• Buffer size in samples.

• Polling rate in milliseconds.
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Illustration 102: Basic Scope Settings

Table 6: Format and Range of the Basic Scope Settings

Description Format Value range

SEC/DIV Time base on the X-axis 0.0001–1.000.000.000 s

Time format Year, month, date, hour, seconds, and milliseconds –

Buffer size Number of data sets in the buffer 0–1.000.000

Polling rate Time in milliseconds between 2 samples –

N O T I C E
For systems with large inertia, a low sampling rate may be used since the value changes slowly. For systems with low inertia, a
high sampling rate is needed.

N O T I C E
Setting Polling Rate to As fast as possible means that MCT 10 Set-up Software does not control the actual time between each
sample. This can lead to a high jitter between 2 samples.

Trigger

The trigger function starts the sampling of values only when a certain value is reached. This reduces the need for large buffer sizes. A
trigger is also a valuable tool to see if values cross borders where the drive does not store any warnings.
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Illustration 103: Trigger Functions

Table 7: Descriptions of the Trigger Functions

Trigger func-
tions

Description

Source Source channel.

Level Level where the trigger has to be activated.

Mode Auto starts the trigger automatically when Resume All is pressed. The trigger line is set to the time when Resume
was pressed. Normal (Norm) activates the trigger when level and slope settings are fulfilled.

Slope Sets if the value must rise (source value goes from low values to high values) or the slope must fall (source value
goes from high values to low values).

Cursor

Style defines the functionality or the cursor. The style contains 5 different possibilities:

• Value XY - Shows the time and value of each signal at the cursor location.

• Value X - Shows the time only.

• Value Y - Shows the value only.

• Delta X - Shows 2 cursors, and the time between the 2 cursors is calculated.

• Delta Y - Works like Delta X, but this time the difference between 2 levels is calculated.

Pointer position defines the default position when a cursor is inserted in Scope.

7.5.4 Reuse of PC Polling Channel Settings

Often, the same settings are used when measuring with the PC polling channel on more than 1 drive. These settings can be reused
either by copying an existing scope folder or by reusing an existing one.

Reconfigure the scope folder connection properties for another drive in the network by double-clicking an added channel. In the
Reconfigure Channel dialog, another drive on the same or a different fieldbus can be selected.

DiagnosticsOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 97Danfoss A/S © 2019.01



e3
0b

t8
03

.1
1

Illustration 104: Reconfigure Channel

7.5.5 Configuring the Drive Real-time Channel

Context:

Drive real-time channel can be selected if the selected drive supports this functionality.
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Procedure

1. Select the relevant drive.

Drive Real-time Channel opens the Scope Properties dialog.

2. Configure the channels depending on what the actual drive supports.
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Illustration 105: Select Drive Real-time Channel

All available parameters are listed by parameter name.

3. Configure the sample rate for each channel using the time format HH:MM:SS:zzz.

4. Configure the sampling mode through:

The trigger event.

Logging mode.

Samples before trigger options.
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Illustration 106: Configure Sampling Mode
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7.5.6 Using Advanced Triggers

Context:

The following example explains the set-up of a trigger, which triggers the collection of data in the drive when the motor speed exceeds
a certain limit.

Set up a comparator in the smart logic control to get a trigger signal when the motor speed exceeds a certain limit:
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Procedure

1. Select the smart logic group.

2. Select a comparator not in use, 1310.0, and set it up to motor speed.

3. Set Comparator Operator 13.11.0 greater than >.
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Illustration 107: Smart Logic View

4. Set Comparator Value 1312.0 to the required value.

5. Set up the trigger event in the Drive Real-time Channel Properties dialog to comparator 0.

6. Set the logging mode to log once on trigger.

7. Press OK to enable the set-up.
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Illustration 108: Trigger Event

8. Press Start (resume) poll to start logging.
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The dialog for defining the real-time log style opens.
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Illustration 109: Real-time Log Style

7.5.7 Drive Real-time Channel Properties

More settings can be configured by right-clicking the Scope window and selecting Properties.

It is possible to reconfigure all drive real-time channel settings and also to configure:

• SEC/DIV and time format.

• Appearance settings.

• Cursor settings.
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Illustration 110: Reconfigure Drive Real-time Channel Settings

Besides being able to reconfigure the settings made from the Drive Real-time Channel Properties dialog, SEC/DIV and the time format
are configurable.
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SEC/DIV

The SEC/DIV and Time format functionalities are similar to the PC polling channel functionality, see 7.5.2 Configuring the PC Polling
Channel.

Appearance

Each channel name can be renamed.

The Units/Div, Position, Marker, and Color functionalities are similar to the PC polling channel functionality.

Cursor

The functionality is similar to the PC polling channel functionality.

7.5.8 Communication Control

The Scope toolbar has 4 main buttons for communication control.

Table 8: Functions of the Control Buttons

Control button Function

Start (data acquisi-
tion)
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.1
2 MCT 10 Set-up Software scope starts collecting the requested data from the drive network.

Stop (data acquisi-
tion)
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.1
2 MCT 10 Set-up Software stops collecting data and there is no communication to the drive

network while the scope part is active on the screen.

Start (resume) all
tracking
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.1
2 Activates the tracking mechanism. MCT 10 Set-up Software starts the readout of variables

to the screen and to the buffer. Variables are checked against the trigger settings. If the
buffer has been partially filled (use of the Pause All Tracking function), MCT 10 Set-up Soft-
ware continues to fill data into the buffer.

Pause all tracking

e3
0b

t5
62
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2 Deactivates the tracking. The buffer remains at its current state, no new data is shown. The

buffer pointer keeps its current position.

7.5.9 Additional Functionality

Select Resume poll to start tracking. To stop tracking, click Stop poll or Pause all tracking. The tracking continues until the buffer is filled
(default 1000 samples). If the tracking stops due to a filled buffer, the buffer has to be emptied before a new track can be activated.
Clear the buffer and reset the scope in 1 step by clicking the icon shown in illustration 115.
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Illustration 115: Clear all Buffer for the Channel

Alternatively, the buffer can be cleared individually.
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Illustration 116: Individually Clearing the Buffer

Table 9: Functions of the Main Buttons

Name Description

Reset scope
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.1
2 Clears all buffers for the channel at once. This is more convenient if many channels are activated

at the same time, or if a new channel is added to an existing track. Before new values can be add-
ed to a track, all channel buffers must be emptied, since MCT 10 Set-up Software requires that all
buffers have the same amount of data.

Export to Excel
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2 Enables storing scope data in a file which Microsoft Excel can open. A Save file dialog appears,

making it possible to store the file in an appropriate location.

Open storage
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1 Enables storing scope data in a file on the hard disk. Save to the hard disk to avoid the limitation

of 1 million points in the project file.

Open scope
history viewer
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1 Open scope data saved on the hard disk.

DiagnosticsOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466104 | Danfoss A/S © 2019.01



7.5.10 Scope Storage

Enable scope storage or persistent data storage in Scope Properties. In Scope Properties, it is also possible to change and select where
data should be saved.
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Illustration 118: Scope Properties

If polling data in scope when scope storage is selected, data is saved in both the project file and on the hard disk. However, the project
file is limited to 1 million points. When the limit is exceeded, MCT 10 Set-up Software replaces the oldest point with the latest point.
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8 Plug-ins

8.1 Smart Logic Controller Plug-in

From version 2.13, MCT 10 Set-up Software supports the smart logic controller plug-in. This feature enables quick set-up of logical
sequence programs.

The smart logic controller monitors a predetermined event. When the specified event occurs, it performs a predetermined act and
starts monitoring the next predetermined event. The smart logic controller continues like this in up to 20 different steps until it returns
to step 1 – monitoring the 1st specified event.

The smart logic controller can monitor any parameter that can be characterized as true or false. This includes digital commands and
logic expressions, which allow sensor outputs to determine the operation. Temperature, pressure, flow, time, load, frequency, voltage,
and other parameters combined with the operators >, <, =, AND, and OR form logic expressions that control the drive logically in any
application.

Refer to the relevant design guide for a full overview of the smart logic controller features.

8.2 Time-based Actions and Preventive Maintenance Plug-ins

For the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, and VLT® AutomationDrive FC 301/FC 302, the MCT 10 Set-up Software
provides the following plug-ins:

• Clock features.

• Preventive maintenance.

• TIme-based actions.

N O T I C E
Consult the relevant design guide for detailed information about the drive.

8.2.1 Clock Functions

The MCT 10 Set-up Software enables set-up of the clock functions.

The clock functions are grouped in 2 sublevels:

• Date and time.

• Working days.

8.2.1.1 Date and Time

In the Date and time dialog, the following groups of settings are available:

• Display format.

• Set date and time.

• Daylight saving time.

• Enable clock fault.
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Display format in LCP

Select how date and time are presented in the LCP on the drive. In MCT 10 Set-up Software parameters, date and time format depends
on PC regional options (date and time format).

Set date and time

Change the date and time in the drive from the PC. Normally, it should be set to use the connected PC’s date and time. When the
connected PC’s time is in another time zone, it is beneficial to set the date and time manually. Date and time are changed in the MCT
10 Set-up Software project file or in the drive only when the Change checkbox is ticked.

Daylight saving time

Set the date and time for daylight saving.

Daylight saving time begins for most of the United States at 2:00 a.m. on the first Sunday of April. Time reverts to standard time at 2:00
a.m. on the last Sunday of October. In the U.S., each time zone switches at a different time. In the European Union, summer time begins
and ends at 1:00 a.m. Universal Time (Greenwich Mean Time). It begins the last Sunday in March and ends the last Sunday in October.
In the EU, all time zones change at the same moment.

Enable clock fault

If the clock is not set up, the drive shows a specific warning. Enable or disable the clock fault function.

8.2.1.2 Defining Working Days

Context:

N O T I C E
Additional working days and non-working days include the year and must be updated every year.
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Procedure

1. Select First day of the week (Monday or Sunday).

2. Select working days and non-working days.

3. Set additional working days (maximum 5).

4. Set additional non-working days (maximum 15).
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Illustration 119: Define Working Days

8.2.2 Preventive Maintenance

Context:

The preventive maintenance feature supports the planning of periodic maintenance of both the drive and other technical equipment.
If the defined date and time of preventive maintenance is passed, the item is marked red.
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Illustration 120: Preventive Maintenance

N O T I C E
Program the clock parameters (parameters in the Clock functions folder) for preventive maintenance to function correctly.

Procedure

1. Double-click the cells in the right view to specify application item, action, and interval.

2. Reset Maintenance Word (in parameter 23-15 Reset Maintenance Word) and write to the drive.

8.2.3 Timed Actions

Context:

The time-based actions function enables automation of real-time controlled events.

Actions, which can be programmed, are the same as known from the SLC (smart logic controller), see 8.1 Smart Logic Controller Plug-
in.

N O T I C E
The clock parameters (parameters in the Clock functions folder) must be correctly programmed for timed actions to function
correctly.
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Illustration 121: Time-based Actions

Procedure

1. Select Timed Actions in the product folder.

2. Double-click the cells in the right view to specify:

Action.

Time.

Recurrence.

8.3 Motor Plug-in

The Motor plug-in is an offline plug-in showing relevant parameters for commissioning of the motor. Select the plug-in from the
structure.
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Illustration 122: Selecting the Motor Plug-in

The parameters shown depend on the setting in parameter 1-10 Motor Construction.
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Illustration 123: Select Motor Type
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8.3.1 Asynchronous Motors
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Illustration 124: Example of Settings for an Asynchronous Motor

8.3.2 PM Non-salient SPM

Context:

For PM motors, calculation buttons are available. Below is an example of how to set parameter 1-25 Motor Nominal Speed.
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Illustration 125: Example of Settings for a Non-salient SPM Motor
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Procedure

1. Enter the frequency and the number of pole pairs.
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Illustration 126: Enter Data for Nominal Speed

2. Click OK to get the value.

When the value is calculated, a notification appears. If the value is out of range, an error message appears and the value
reverts to the previous value.

e3
0b

t9
95

.1
0

Illustration 127: Notification Stating that the Value has Changed
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Illustration 128: Error Message when the Value is out of Range

Changing the number of pole pairs in parameter 1-25 Motor Nominal Speed also changes the value of parameter 1-39 Motor
Poles.
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Illustration 129: Changing Number of Pole Pairs Affects 2 Parameters

8.3.3 PM Salient IPM

Same functions and behavior as PM, non-salient SPM.
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Illustration 130: Examples of Settings for a Non-salient IPM Motor

Plug-insOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 115Danfoss A/S © 2019.01



8.3.4 SynRM
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Illustration 131: Examples of Settings for a SynRM Motor

8.4 Multi-motor Plug-in

In applications where 1 drive controls multiple motors/fans, a motor or motor/fan coupling failure may pass unnoticed due to missing
feedback from the controlled fan. One or a few motor failures may be less critical during low or normal operating load, but it can lead
to a full stop of the system in high-load situations. The multi-motor plug-in monitors and diagnoses the fan/motor state. The plug-in is
limited to 8 motors of equal size and type. The multi-motor calculation tool is only for variable torque applications.

Find the multi-motor plug-in in the drive folder on the left side of the screen. Use the plug-in either online directly connected to a drive
or offline for download later. Find the relevant parameters in parameter group 24-9* Application Functions 2.

N O T I C E
The multi-motor plug-in does not work on motors connected in parallel.

To get the right values, measure the current throughout the whole frequency band (from 0 Hz to maximum), also below the normal
operating points.

Failures or underload of motors issue a missing motor warning. The drive continuously checks if the total motor current is below the
expected value, which indicates situations where:

• One or more motors are missing/disconnected.

• One or more fans are loose.
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Overload of motors issues a locked rotor warning. The drive continuously checks if the total motor current is above the expected value,
which indicates situations where:

• A rotor is locked.

• A fan touches the housing.

N O T I C E
During start-up or dynamic events like changes in speed references, the current may be below/above the current threshold.
Consider and evaluate whether such situations may occur.

8.4.1 Defining Normal Operation Curve

Context:

The plug-in provides an easy way to find the coefficients of the 3rd order polynomial by measuring currents on different frequencies.

N O T I C E
To avoid wrong logical minimum in the 3rd order polynomial, enter the lowest possible frequency into the tool.

N O T I C E
Points can be inserted at any frequency, but the defaults are recommended as the points are not saved. Only calculated
coefficients are saved and used to recalculate the points on default frequencies after closing and opening the view.

Procedure

1. Measure normal operation currents on 5 different frequencies.

2. Insert the frequencies in Normal operation currents.
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Illustration 132: Normal Operation Currents

8.4.2 Threshold

Measured points show normal operation curves. Settings in Motor Data define the threshold of the upper and lower limits.
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Illustration 133: Threshold

• Number of motors is a convenience value to reduce the tolerance bandwidth, dividing it by the number of motors used (maximum
8 motors).

• Tolerance defines the bandwidth as a percentage of the highest measured current.

N O T I C E
These settings are not saved and are recalculated after closing and opening the view. If the values are different after
recalculation, they still define the same tolerance. Example: 4 motors with 20% tolerance produce the same bandwidth as 2
motors with 10% tolerance.

8.4.3 Coefficients

Locked Rotor Detection and Missing Motor Detection show parameter values exactly as they are written to the drive. The values are
synchronized automatically.
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Illustration 134: Locked Rotor Detection and Missing Motor Detection

N O T I C E
Cubic and quadratic coefficients are multiplied by 1000 to overcome precision limitation of parameters.

8.4.4 Modified Curves

Changing the frequency of a measured point moves the point along the defined curve. As the point follows the previously defined
curve, the change of frequency only causes a slight change to the curve.

8.5 Cascade Controller Plug-in

The cascade controller is intended for pump applications where multiple motors control a common flow, level, or pressure. By varying
the speed of the motors, variable speed control is provided for the system. This maintains constant pressure while eliminating pressure
surges, resulting in reduced system stress and quieter operation.
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Three versions of cascade controllers are available:

• Basic cascade controller

- Delivered as part of the software in the VLT® HVAC Drive FC 102 and VLT® AQUA Drive FC 202. The 2 relays on the power card
control the speed of a device connected to the drive output and on/off control devices.

• Extended cascade controller

- Allows more devices to be applied to the control circuitry and offers more cascade principles. It is available only in the FC 202
with a VLT® Extended Cascade Controller MCO 101 option card installed.

• Advanced cascade controller

- Offers the cascade principles similar to extended cascade, but allows extra devices to be applied to the control circuitry. It is
available only in the FC 202 by using the VLT® Advanced Cascade Controller MCO 102 option card.

The add-on option cards MCO 101 and MCO 102 can be used with the basic cascade controller (parameter group 25- ** Cascade
Controller) and with the extended/advanced cascade controller (parameter group 27-** Cascade CTL Option).

The cascade controller can be configured in MCT 10 Set-up Software from the cascade controller plug-in. Basic mode supports the
basic cascade controller, and extended mode supports the extended/advanced cascade options MCO 101/MCO 102.

The MCT 10 Cascade Controller view is divided into 4 tabs in both cascade modes:

• Preconditions.

• Set-up.

• System Optimizing.

• Service.

8.5.1 The Preconditions Tab

The Preconditions tab contains the general set-up required for the cascade controller to operate in an application. It can also be used in
general to set up the closed loop for other applications without the need for the cascade control. Use Preconditions to configure:

• General configuration.

• Setpoint and feedback.

• Digital input.
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Illustration 135: Preconditions.

8.5.1.1 General Configuration

Closed loop is the configuration mode of the drive. Enabling or disabling the checkbox changes parameter 1-00 Configuration Mode.

Table 10: Closed-loop Checkbox Options

Options Parameter 1-00 Configuration Mode

Enabled [1] Closed loop

Disabled [0] Speed open loop
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Level control configures the inverse mode of the PID controller. It causes the drive output frequency to increase when the feedback is
greater than the setpoint reference. If the checkbox is disabled, the PID is configured to normal control. Digital I/O mode and DI 32 are
enabled.
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Illustration 136: Level Control

Enabling the checkbox configures the PID to inverse control and digital I/O mode and DI 32 are disabled. The drive graphic is updated
to reflect the general configuration.
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Illustration 137: General Configuration

The setpoint is used in closed loop as the reference to compare the feedback values. It can be offset with the digital, analog, or bus
references. Enabling the internal setpoint allows for entering a numerical value for the reference source. If the external setpoint is
selected, the reference source is set to AI53. The internal setpoint settings remain in the field allowing to switch between a preset- or
an external setpoint.

Setpoint and feedback unit type configures the pressure unit for the closed-loop setpoint and feedback. The pressure unit can be
defined in:

Plug-insOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 121Danfoss A/S © 2019.01



• %.

• mbar.

• bar.

• Pa.

• kPa.

• m WG.

• psi.

• lb/in2.

• in WG.

• ft WG.

General configuration affected parameters

• Parameter 1-00 Configuration Mode.

• Parameter 20-81 PID Normal/ Inverse Control.

• Parameter 3-15 Reference 1 Source.

• Parameter 20-12 Reference/Feedback Unit.

8.5.1.2 Setpoint and Feedback

Configure the analog input used as setpoint and feedback. The general configuration assumes the AI 53 (analog input 53) is used for
the setpoint and the AI 54 (analog input 54) is used as feedback. The signal type can only be changed from current to voltage input
with the switches on the control board of the drive. Click Show location to see the specific location on the drive.
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Illustration 138: AI53 and AI54
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Configure the signal type in accordance with the hardware switches.
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Push the switch to the left to get a 0–10 V signal type. Push the switch to the right to get a 0–20/4–20 mA signal type.

Setpoint high and Feedback high configure the analog input scaling value corresponding to the maximum reference feedback value.
Setpoint low and Feedback low are used to configure the analog input scaling value corresponding to the minimum reference feedback
value. The minimum and maximum references are the lowest and highest values obtainable by adding all references together.

To receive notification of a missing or defective transmitter, define live zero among the functions:

• Off.

• Freeze output.

• Stop.

• Jogging.

• Maximum speed.

• Stop and trip.

• Select set-up 1.

• Select set-up 2.

• Select set-up 3.

• Select set-up 4.

The function is activated if the signal on terminal AI 53 or AI 54 is below 50% of the value defined in AI 53 low or AI 54 low. Default Live
Zero Timeout time is 10 s and can be reconfigured in parameter 6-00 Live Zero Timeout Time.

Enable Terminal 53 live zero and Terminal 54 live zero to disable the live zero monitoring if the analog outputs are used as part of a
decentral I/O system. As default, both checkboxes are enabled.
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Setpoint and feedback affected parameters

• Parameter 3-02 Minimum Reference.

• Parameter 3-03 Maximum Reference.

• Parameter 6-01 Live Zero Timeout Function.

• Parameter 6-10 Terminal 53 Low Voltage.

• Parameter 6-11 Terminal 53 High Voltage.

• Parameter 6-12 Terminal 53 Low Current.

• Parameter 6-13 Terminal 53 High Current.

• Parameter 6-14 Terminal 53 Low Ref./Feedb. Value.

• Parameter 6-15 Terminal 53 High Ref./Feedb. Value.

• Parameter 6-17 Terminal 53 Live Zero.

• Parameter 6-20 Terminal 54 Low Voltage.

• Parameter 6-21 Terminal 54 High Voltage.

• Parameter 6-22 Terminal 54 Low Current.

• Parameter 6-23 Terminal 54 High Current.

• Parameter 6-24 Terminal 54 Low Ref./Feedb. Value.

• Parameter 6-25 Terminal 54 High Ref./Feedb. Value.

• Parameter 6-27 Terminal 54 Live Zero.

8.5.1.3 Digital Input

If a low-level signal is available, the DI32 (digital input 32) can be programmed to stop inverse or to external interlock, and an external
interlock delay can be configured. The type of pulse to trigger can be configured from the digital I/O mode drop-down list.

8.5.2 The Set-up Tab

The Set-up tab contains the configuration interface for the cascade controller, parameter group 25-** Cascade Controller. The cascade
principle can be configured to Basic Cascade Ctrl or Motor Alternation Only (VLT® AQUA Drive FC 202 only).
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Illustration 141: Configuration Interface for Parameter Group 25-** Cascade Controller

8.5.2.1 Basic Cascade Control

Select basic cascade control to configure:
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• Motor start.

• Pump configuration.

• Staging/destaging settings.
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Illustration 142: View of Basic Cascade Control Set-up Tab

Table 11: View and Selection Descriptions

View Description

Motor start The view defines the configuration principle:

• Direct on line – each lag pump is cut in directly via a contactor.

• Soft starter – must be used for all fixed speed pumps and can be used to replace traditional contactors.
When using soft starters, a delay is added from the staging signal occurs until staging takes place. The de-
lay is required due to the ramp time of the fixed speed pump.

Enable pump cy-
cling

The view defines whether the pump cycling is enabled or not:

• Disabled – lag and lead pumps are cut in to have equal hours run for each pump.

• Enabled – lag pumps are cut in according to the first-in, last-out principle.
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View Description

Fixed lead pump This view defines whether a drive uses a fixed lead pump or not. The lead pumps are connected directly to the
relays on the drive control card. This is shown in illustration 142. To obtain equal hours of operation within the
fixed speed pumps, the lead pump can be alternated. Timers on the relay outputs monitor the hours run of
each pump. When a pump is not operating for a long time, corrosion may become an issue. When it is config-
ured for alternating lead pump, select Alternation details to set up principles for alternation.

Lead pump alter-
nation

This view instructs the drive to change the lead pump so all pumps run for the same period. The following
options are available:

• Off - no lead pump alternation occurs.

• At staging - lead pump alternation occurs at pump staging.

• At command - lead pump alternation occurs at explicit commands.

• At staging or command - lead pump alternation occurs at pump staging and at explicit commands.

Alternation time
interval

In this view, define the time period between automatic alternation of the lead pump:

• 1–999.9 h - when the time expires, the lead pump alternates.

Alternation time
value

This view contains the actual value of the alternation timer.

Alternation pre-
defined time

In this view, set the time to perform an alternation. The time format depends on the settings configured in the
drive.

Alternate if load
<50%

In this view, define whether the lead pump must be alternated:

• Enabled - pump alternation is carried out only if the capacity is equal to or below 50%.

Staging mode at
alternation

In this view, configure the staging mode at alternation and determine the time of the variable speed pump
deceleration:

• Quick.

• Slow.

Delay before cut-
ting in next
pump

In this view, set the time between stopping the old lead pump and starting another. Range: 0.1–5.0 s.

Delay before cut-
ting in on mains

Time delay before a fixed speed pump is staged on according to normal staging sequence. When it expires, a
fixed speed pump must be staged on according to normal staging. Range: 0.1–5.s.

Staging/destag-
ing settings

In this view, configure when to add and remove a stage from a running application. A stage is a representation
of a 100% pump.

Staging band-
width (SBW)

In this view, define the band around the head setpoint and configure it as a percentage of the maximum refer-
ence. If the actual head exceeds the bandwidth for a specified time and the speed is at motor speed high limit,
a stage is added. If the speed is at motor speed low limit, a stage is removed. Range: 1–100%.

Override band-
width (OBW)

Preserves a stable head in the application. When quick changes in the system demands occur, the override
bandwidth must add/remove a stage immediately when the actual exceeds override bandwidth. To avoid un-
intended staging until the head has settled after start, override bandwidth has a delay until the lead pump has
reached motor nominal speed or motor speed high limit after a start command. Range: SBW to 100%.

Fixed speed
pumps staging
bandwidth
(FSBW)

Ensures that the cascade controller continues if the drive issues an alarm. Keeping the head on the setpoint
requires a frequent staging and destaging. When only fixed speed pumps are running, a wider bandwidth
(FSBW) is used instead of SBW. Range: SBW to OBW.

OBW timer Avoids frequent staging/destaging. The OBW timer prevents staging a pump until the application pressure is
stabilized. Range: 0–300 s.
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View Description

SBW staging de-
lay

Delay between the feedback signal being below the staging bandwidth and a lag pump being added. SBW
destaging delay is the time between when the feedback signal is above the staging bandwidth and when a lag
pump is removed. Range: 0–3000 s.

Ramp-down de-
lay and ramp-up
delay

For use with soft starters. The ramp-down delay is for setting the lead pump ramp-down delay before staging a
fixed speed pump on. Ramp-up delay is for setting the lead pump ramp-up delay before a fixed speed pump is
destaged.

Stage- and de-
stage threshold

The percentage of maximum pump speed to stage on and to destage fixed speed pump. The thresholds must
be configured as a percentage of motor speed high limit.

Destaging speed To prevent an overshoot when adding a fixed speed pump, the variable speed pump ramps to motor speed
low limit. When the variable pump reaches staging speed, the fixed speed pump is staged on. To prevent an
undershoot when removing a fixed speed pump, the variable speed pump ramps to motor speed high limit.
Available options: RPM or Hz.

Enable staging
function

Avoids frequent staging of fixed speed pumps. Enabling the checkbox starts the stage function timer. Enable
destage function ensures that the lowest numbers of pumps are running to save energy and to avoid dead
head water circulation in the variable speed pump. Enabling the checkbox starts the destage function timer.

Table 12: Number of Pumps Configurable from the Drop-down List

Function Number of pumps

Fixed lead pump 2–3

Alternating lead pump 2
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Illustration 143: Alternation Details

If configuring the lead pump alternation At command or At staging or command, the alternation event can be configured to:
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• External - Alternation takes place when a signal is applied to 1 of the digital inputs in the terminal strip.

• Alternation time interval - Alternation takes place every time the alternation time interval expires.

• Sleep mode - Alternation takes place each time the lead pump goes into sleep mode. The no-flow function must be set to sleep
mode or an external signal applied for this function.

• Predefined time - Alternation takes place at a defined time of the day. If Alternation predefined time is set, the alternation is carried
out every day at the specified time.
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Illustration 144: Staging and Destaging Details

Stage function time is the time before staging on a fixed speed if the lead pump is at maximum speed. The stage timer starts when the
adjustable speed pump is running at motor speed high limit with 1 or more constant speed pumps stopped. When the timer expires, a
fixed speed pump is staged. The destage function time is the time before staging on a fixed speed if the lead pump is at minimum
speed. It starts when the adjustable speed pump is running at motor speed low limit with 1 or more fixed speed pumps in operation.
When the timer expires, a stage is removed avoiding dead head water circulation within the adjustable speed pump.

If the Destage at no-flow checkbox is enabled, a stage is removed when there is a no-flow situation.

8.5.2.2 Motor Alternation Only

In Motor alternation only, 1 drive and 2 pumps are connected through contactors to both the drive and to mains. The functionality is
used to allow the alternation between pumps that share a drive. The alternation takes place at an external command signal or a
preprogrammed event.

8.5.3 The System Optimizing Tab

The System optimizing tab provides a simple way to start and stop the cascade controller. It allows configuration of:

• PID controller.

• Feedback low-pass filter.
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Illustration 145: Start and Stop Cascade Controller

Table 13: Description of PID functions

Field Description

PID anti-
windup

Controls the integration of the PID controller. If the checkbox is enabled, the PID controller stops integrating the
error between the feedback and the setpoint reference if it is not possible to adjust the output frequency of the
drive to correct the error. This situation can occur when the drive has reached the minimum or maximum output
frequency, or when the drive is stopped. If the checkbox is disabled, the PID controller continues integrating the
error between the feedback and setpoint reference, even though the drive cannot adjust its output frequency to
correct this error.

PID propor-
tional gain

Adjusts the output of the drive's PID controller based on the error between the feedback and the setpoint reference.
Quick PID controller response is obtained using a large value. If too large, the drive output frequency may become
unstable. The value is configurable from 0–10.00.

PID integral
time

The duration of integrating the error between the feedback and the setpoint reference to ensure the error ap-
proaches 0. Quick speed adjustments are obtained using a short duration. At a too short value, the drive output
frequency may become unstable. The time is configurable from 0.01–10000.00 s.

PID differen-
tiation time

The time the differentiator monitors the rate of change of the feedback. If it is quickly changing, it adjusts the out-
put of the PID controller to reduce the rate of change of the feedback. Quick PID controller responses are obtained
using a long duration of time. However, at too large values, the drive output frequency may become unstable. Dif-
ferential time is useful in situations where fast responses and precise speed control are required. The time is config-
urable from 0.00–10.00 s.

Terminal 54
Filter Time
Constant

A first-order digital low-pass filter constant for suppressing electrical noise from terminal 54. A high time constant
improves the dampening, but also increases the time delay through the filter. The value can only be adjusted while
the drive is stopped. The time constant can be configured from 0.001–10.000 s.

8.5.4 The Service Tab

The Service tab provides a simple way to make cascade controller service.
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Table 14: Service Tab Views

View Description Basic
cascade
control-
ler

Exten-
ded cas-
cade
control-
ler

Cascade status – ✓ ✓

Pump status Readout of the status for each pump selected with a string, which consists of the
pump number and the current status of the pump. A readout with 2 pumps could be
1:D 2:O.

• 1:D – Pump 1 running on drive.

• 2:O – Pump 2 off.

✓ ✓

Lead pump Shows the actual lead pump in the application. When an alternation takes place, the
field is updated to reflect the current lead pump.

✓ ✓

Manual alterna-
tion

Select a new lead pump. The items available from the drop-down list are Off for the
number of pumps.

✓ ✗

Relay status Select relay status to update the status of the relays. The status can be

• On - the relay is activated.

• Off - the relay is deactivated.

The values can only be updated if the drive is online.

✓ ✓

Relay ON time Monitors the total hours run of the connected relay. The resolution is in hours run. Re-
set relay counter resets all relay on-times. It is only available, if the drives are connec-
ted online.

✓ ✗

Pump interlock Disables a certain pump and is configurable from a checkbox at each pump. ✓ ✗

Pump ON time Monitors the total hours run of the connected pump. The resolution is in hours run.
Reset clears the hours run of a specific pump.

✓ ✗

Current run-time
hours

Readout of the total number of hours run for each pump since last reset. The time is
used to balance the hours run between pumps.

✗ ✓

Pump total life-
time hours

Total hours run for each connected pump. ✗ ✓

Manual pump
control

Readout of the command parameter that allows manual control of individual pump
states.

✗ ✓

Reset relay coun-
ter

Resets all relay on-times. Only available if the drive is online. ✗ ✓

Plug-insOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466130 | Danfoss A/S © 2019.01



e3
0b

t7
46

.1
1

Illustration 146: Service Tab Basic Cascade Controller
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Illustration 147: Service Tab Extended Cascade Controller

Table 15: Status Descriptions

View Status Status description

Cascade status Disabled The cascade controller is disabled.

Emergency All pumps have been stopped by a coast/coast inverse or an external interlock com-
mand applied to the drive.

Off All pumps have been stopped by a stop command applied to the drive.

In open loop Configuration mode has been set for open loop. All fixed speed pumps are stopped,
and the variable speed pump continues to run.

Frozen Staging/destaging of pumps has been locked and the reference is locked.

Jogging All fixed speed pumps are stopped. When stopped, the variable speed pump runs at
jog speed.

Running A start command is applied to the drive and the cascade controller controls the
pumps.

Running FSBW The drive is tripped and the cascade controller controls the fixed speed pumps based
on fixed speed bandwidth.

Staging The cascade controller is staging fixed speed pumps.

Destaging The cascade controller is destaging fixed speed pumps.

Alternating The lead pump alternation selection is different than Off and an alternation sequence
is taking place.

Lead not set No pump available to be assigned as variable speed pump.
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View Status Status description

Pump status X Disabled. The pump is interlocked either via pump interlock or signal on a digital input
programmed for pump interlock in digital inputs.

Off Stopped by the cascade controller, but not interlocked.

D Running on drive, regardless of whether the variable speed pump is connected direct-
ly or controlled via relay in the drive.

R Running on mains. Fixed speed pump running.

Relay Status (1) On The relay is activated.

Off The relay is deactivated.

Manual pump control (2) No operation The function is disabled.

Online Makes the pump available to the cascade controller.

Alternate On Forces the selected pump to be the lead pump.

Offline-Off Turns off the pump and makes the pump unavailable for cascading.

Offline-On Turns on the pump and makes the pump available for cascading.

Offline-Spin Initiates a pump spin.

1 Only available in basic cascade controller.
2 Only available in extended cascade controller.

Relay status enables readout of the function and status of each relay.
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Illustration 148: Relay Status
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8.5.5 Extended Cascade Controller Options

The extended cascade controller offers 2 cascade modes that are not available in basic cascade control. The 2 modes are:

• Master/Follower.

• Mixed Pumps.

8.5.5.1 Set-up

Set-up is the interface for setting up the add-on cascade controller option. The Cascade mode drop-down list is extended with Master/
Follower and Mixed Pumps.
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Illustration 149: Cascade Mode Drop-down List

8.5.5.2 Master/Follower

The master/follower function allows configuring:

• Motor start.

• Pump configuration.

• Connections.

• Staging/destaging.

• Master pulse output signal.

• Spin time unused pump.

• Run-time balancing.
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Illustration 150: Master/Follower

The motor start drop-down list is similar to the configuration available in 8.5.2.1 Basic Cascade Control.

Each pump is controlled by a drive and the number of drives correspond to the number of pumps. Staging and destaging are done
based on the speed of the drive. The constant pressure is controlled by the master drive operating in closed loop. Up to 6 pumps can
be controlled with VLT® Extended Cascade Controller MCO 101 and up to 8 pumps with the VLT® Advanced Cascade Controller MC 102.

Select Connections to configure the relay function for each relay in the application.
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Illustration 151: Configure Relay Options

N O T I C E
The number of available relays depends on the add-on option.

To set up the function of each relay, double-click the Value field and select the relay from the drop-down list. If add-on option MCO 102
is installed, the relay option VLT® Relay Card MCB 105 may also be used as an expansion.

Select Staging/Destaging settings to configure when to add and remove a stage from a running application. All stages are a
representation of 100% pumps in Master/Follower.
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Illustration 152: Staging and Destaging Details
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Table 16: Staging and Destaging Description

Field Description

Normal operating
range

The allowed offset from the setpoint before a pump may be added or removed. The system must be
outside of the limit for the time specified in Staging delay.

Override limit The allowed offset from the setpoint before a pump immediately is added or removed.

Autotune stage/
destage threshold

Optimizes the threshold values during operation. The settings are updated to prevent pressure over-
shoots and undershoots when staging and destaging.

Autotune stage on/off
speeds

Stage on and off speeds are continually autotuned during operation. Settings are optimized to ensure
high performance and low energy consumption.

All supported stages On and Off settings can be configured in RPM or Hz. Select Example to see a configuration example of 3 pumps.

Ramp-down delay and ramp-up delay are only configurable when motor start is configured to soft starter.

Select Master pulse output signal to configure terminal 27 on the master drive.
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Illustration 153: Master Pulse Output Signal

In some applications, not all pumps are used regularly. Select Spin time unused pump to configure the time a pump is allowed to idle.
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Illustration 154: Spin Time Unused Pump
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Select Runtime balancing to balance the running hours of the available pumps. Three balancing priorities are available for each pump.
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Illustration 155: Balancing Running Hours

8.5.5.3 Mixed Pumps

Select Mixed pumps to configure:

• Motor start.

• Pump configuration.

• Pump size.

• Connections.

• Alternation details.

• Staging/destaging settings.

• Spin time unused pump.

• Runtime balancing.

The motor start drop-down list is similar to 8.5.2.1 Basic Cascade Control, but with the additional possibility to configure star/delta.

Mixed Pumps Cascade Mode can be configured to:

Table 17: Mixed Pump Cascade Mode

Mode Description

Mixed pump A mix of variable speed pumps connected to drives and more fixed speed pumps.

Unequal size pump Limited mix of fixed speed pumps in different sizes.

Mixed pump with alternation Alternates the drive between 2 pumps along with controlling more fixed speed pumps.

Select Pump size to configure the fixed pump capacity in the application. All variable speed pumps are read-only and 100% in capacity.
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Illustration 156: Configure Fixed Pump Capacity

For configuration of connection, refer to 8.5.5.2 Master/Follower. For mixed pump alternation details configuration, refer to 8.5.2.1
Basic Cascade Control.

The dialog Staging and destaging details is similar to 8.5.2.1 Basic Cascade Control with the additional option to configure minimum
speed destage delay. Configure for how many seconds the lead pump must run at minimum speed while system feedback is in normal
operation band. When the time has elapsed, the pump turns off to save energy.

e3
0b

t7
55

.1
0

Illustration 157: Staging/Destaging

Spin time unused pump and Runtime balancing configurations are similar to the master/follower configuration.
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8.6 Drive File Manager Plug-in

8.6.1 Customer-specific Initialization Values - CSIV

The Drive file manager provides the functionality to download files containing customer-specific initialization values (CSIV), language
files, and application wizard files to the drive. CSIV files contain parameter sets that can be used to initialize the drive to reduce the
time for commissioning. Files can only be flashed via the fieldbus RS485 and USB with the drive serial address configured to 1.

Table 18: Available Features

View
drive
flash file
system

Download
CSIV files

Delete
CSIV
files

Download
language
files

Delete
language
files

Download
application
wizard files

Delete
applica-
tion wiz-
ard files

Splash
screen

VLT® Micro Drive FC
51

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC Basic
Drive FC 101

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC Drive FC
102

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® AQUA Drive FC
202

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® Automation-
Drive FC 302

Yes Yes Yes Yes Yes Yes (1) Yes (1) Yes

Derived versions of
the FC Series

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® Advanced Filter
AAF 006

Yes Yes Yes Yes Yes N/A N/A N/A

1 Only FC 302 from firmware version 6.6x.

The functionality is available as a plug-in named Drive file system and is accessible both from the network and project nodes.
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Illustration 158: Drive File Manager Plug-in
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From the network node, it is only possible to view the content in the Drive flash system. It requires a change of the drive serial protocol
parameter 8-30 Protocol to [1] FC MC. CSIV and language files can only be downloaded from the project node.

8.6.2 Creating New CSIV Files

Context:

N O T I C E
To import existing CSIV files or language files to the list, select Import file from the menu.

N O T I C E
To export CSIV files containing initialization values to a file, select Export file from the menu. From the file menu, it is possible to
cut, copy, paste, delete, or renaming existing files from the list.

Procedure

1. Right-click the right pane of the Drive file manager.

2. Select New File and CSIV File.
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Illustration 159: Create CSIV Files

An empty CSIV file is created and listed in the right view with the default name starting from 1.

8.6.3 Configuration of CSIV Files

The CSIV file content is autogenerated based on the settings configured in the File menu.
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• Full change set builds up the CSIV file content based on the user-made changes in the project including all the dependent
parameters.

• Minimal change set builds up the CSIV file content based on user-made changes only. Selecting this option, the CSIV files are
independent of the drive firmware version, except if 1 of the user-configured parameters is not available.

Use an editor to configure the CSIV file. To open the editor, double-click a file from the list or select Edit File from the menu.
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Illustration 160: Parameter Settings Imported from the Project and the Actual CSIV File Content

The left view contains the parameter settings imported from the project. The right view lists the actual CSIV file content.

• Edit the relevant parameter settings in the Edit parameters below view.

• It is possible to undo the changes made from the Options menu.

• Revert parameters to project drive settings apply to initialization values to CSIV file contents corresponding to the original project.

• Reset to default values resets all parameters to factory configuration and erases the CSIV file content.

• Click Save to save parameter settings from the file content to the CSIV file.

• Click Cancel to discard all changes and close the CSIV editor.

As part of the CSIV content, the drive information is also saved to the file. When opening the file in the CSIV editor, a validation is made
to check for compatibility.
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Illustration 161: Validation

When parameter settings have been saved to the file, open it for validation.

8.6.4 Drive File Manager

Files can be downloaded or existing files deleted in the drive via the Drive File Manager available from the menu.
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Illustration 162: Drive File Manager

The drive is set into service mode when opening the Drive file manager.
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N O T I C E
If the connection is lost, or the drive is power cycled, the drive remains in service mode. It can be forced back to normal mode
with the Software upgrade plug-in.
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Illustration 163: Service Mode

The Drive file manager is divided into a left pane named Project drive and a right pane named Connected drive.

• Project drive lists the files in the project.

• Connected drive lists the files present in the drive flash file system.
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Illustration 164: Present Files

Three buttons are located in the middle of the view. The right arrow transfers the files from the project to the drive flash file system.

Illustration 165: Right Arrow

The left arrow transfers the files from the drive flash file system to the project.
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Illustration 166: Left Arrow

The Exit button closes the Drive file manager and switches the drive back to normal mode.

Illustration 167: Exit

8.7 Functional Safety Configuration Plug-in

8.7.1 Introduction

The VLT® Safety Option MCB 15x Series is defined in the safety configuration plug-in:

• Configuration of the safety functions for safe motion shuts down the drive if an error occurs.

• Setting of:

- Limit values.

- Braking ramps for the safety functions.

- Monitoring of motion sequences.

The VLT® AutomationDrive FC 301/FC 302 Operating Guide contains important information about safety systems that must be used to
mount and set up the speed monitoring safety functions of the MCB 15x module.

2

3

MCT 10

1
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Illustration 168: System Overview
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8.7.1.1 Safe Option Compatibility

The VLT® Safety Option MCB 15x Series is supported from SW version 6.64 of VLT® AutomationDrive FC 301/FC 302. Previous versions
are not supported. MCB 15x Safe Plug-in supports the following fieldbusses:

• Serial communications:

- RS232 to RS485

- USB to RS485

• USB

• PROFIBUS DP-V1

The MCT 10 safe plug-in for the VLT® Safety Option MCB 15x Series offers the following features:

• Offline project planning and preparation for safety functions.

• Commissioning of safety configurations.

• Creating back-ups of safety configurations.

• Safe option diagnosis.

• Monitoring the behavior and fault codes of active drives.

8.7.2 Access

8.7.2.1 Password Management

Access to the VLT® Safety Option MCB 15x Series is restricted with passwords. The password is requested at every commissioning of a
new set-up for the device.
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8.7.2.2 Accessing the Safe Plug-in for VLT® Safety Option MCB 15x Series

Procedure

1. Expand the drive's network or project view.

2. Expand the relevant drive to show its contents.
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Illustration 169: The Safe Plug-in for MCB 15x (Safe) shown with Functional Safety Icon in Project Tree

If there are multiple separate online or offline drives, select the relevant drive to monitor from the structure tree.

N O T I C E
The parameters that can be edited using the safe plug-in for MCB 15x are also included in parameter group 42-** Safety
Functions in the All Parameters group of the structure tree. These parameters can only be edited using the safe plug-in for
MCB 15x.
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To review Parameter group 42-** Safety Functions in the All parameters view, expand the All parameters group beneath the wanted
drive and select the 42-** Safety Functions entity. The parameter grid is shown on the right.

8.7.3 Safe Plug-in Interface

The layout of the plug-in is divided into separate sections that are all described in more details in this chapter.
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Illustration 170: The Opening Tab of the Safe Plug-in for VLT® Safety Option MCB 15x Series Plug-in Interface (Operating in Offline Mode)

The safe plug-in for the MCB 15x features tooltips for all plug-in interface components. Briefly hovering the mouse cursor over any
interface component reveals a tooltip detailing the current option, LED, or tab header. Refer to these tooltips for quick and easy help
information.

e3
0b

c9
35

.1
1

Illustration 171: Tooltip Example
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8.7.3.1 Information and Administration Area

Illustration 172: Safe Plug-in for VLT® Safety Option MCB 15x Series Information and Administration Area

The information area at the top of the plug-in interface shows the current safe plug-in for MCB 15x profile name and notifies about
pending changes.

Depending on the mode, further options are available in the information area.

• Offline mode: If a drive is connected, press Write to drive and upload the configuration to the MCB 15x.

• Online mode: Two more selections are present in the Information area:

- Administration

- Change password

The Notification icon is shown when there are changes pending for the drive that have not yet been written to it. This icon is shown at
every configuration update. The icon is removed from the view only after a successful commissioning procedure.

8.7.3.2 LED Status Area

The left-hand side of the safe plug-in for the VLT® Safety Option MCB 15x Series contains the Status pane. The Status pane contains
informative LED status icons that help to monitor the functionality and status of the safe plug-in for MCB 15x configuration entities.
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Illustration 173: LED Status Area
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N O T I C E
The LED icons are active only when the safe plug-in for MCB 15x is accessed in online network mode. When working in offline
project mode, the LEDs remain inactive (gray).

Table 19: LED Status Information

LED status Description

Green OK state - the option is enabled or active.

Flashing green Pending state - the option is pending. This applies only to DI1 and DI2 LEDs.

Yellow Active state - the option is active.

Flashing red Warning state - the option has encountered a warning state.

Red Error state - the option has encountered an error.

Gray Off state - the option is either disabled, offline, or inactive.

Table 20: LED Status Information

LED Status

DI1 Status of digital input 1.

DI2 Status of digital input 2.

S37 Status of S37 safe output for terminal T37 on the drive.

STO Status of Safe Torque Off.

SS1-A Status of Safe Stop 1 A.

SS1-B Status of Safe Stop 1 B.

SLS-A Status of Safely Limited Speed A.

SLS-B Status of Safely Limited Speed B.

SMS Status of Safe Maximum Speed

Power cycle re-
quired

This LED lights up when the device requires a power cycle.

Yearly test needed Digital inputs must be tested once a year. A warning indicates when it is time to perform the test.

Blank initial If the LED lights up, the MCB 15x is in a blank initial state, that means in factory settings. When writing to the
MCB 15x for the 1st time, provide a new password.

Error The MCB 15x has detected an error. The specific fault code is shown in the fault code display below the error
LED: For more information regarding fault codes, refer to 13.3.3 Warnings and Alarms.

8.7.3.3 Configuration Area

The configuration area contains dedicated sections/tabs for configuring the safety functions.

The sequence of tabs shows the order in which the settings should be configured.

The following sections detail the contents of the configuration tabs:
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• General speed monitoring.

• Safe input.

• Safe Stop 1.

• Safely limited speed.

• Safe Maximum Speed

The last tab, Parameters, contains a table layout of all configuration options, intended for advanced users.

8.7.3.4 General Speed Monitoring

The General Speed Monitoring tab contains primary and general information regarding the encoder/proximity switch feedback set-up
details.
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Illustration 174: Speed Monitoring Configuration Tab

The left side of the tab contains the following configuration options:

Table 21: Options for General Speed Monitoring

Option Description

Measured
speed source

This option defines the measured speed feedback source. The following options are available:

• Safe plug-in for VLT® Safety Option MCB 15x Series - the feedback source is safe plug-in for MCB 15x.

• None - no feedback source is used.

• Factory default: [Safe plug-in for MCB 15x].
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Option Description

Mounting type This option defines where the encoder is mounted. The following options are available:

• Gear mounted - the encoder reading the speed is mounted on a shaft using a gear system.

• Motor shaft mounted - the encoder is mounted directly to the motor shaft.

• Sensorless - the drive is mounted with the VLT® Sensorless Safety MCB 159 option. The encoder senses the
motor speed via back EMF.

Gear ratio This option defines the ratio between motor shaft and the encoder speed.

0.0001 and 32.0000.

Factory default: 1.0000.

VLT® Safety Op-
tion MCB 150
encoder resolu-
tion

This option defines the encoder resolution connected to the safe plug-in for MCB 15x.

Range: 1 and 4096 PPR for HTL, and 1 and 1000 PPR for TTL.

Factory default: 1024 PPR.

Encoder direc-
tion

This option provides the option to change the detected encoder rotation direction without altering the wiring to
the encoder itself. The following options are available:

• Clockwise - that is positive feedback when the encoder rotates clockwise.

• Counterclockwise - that is positive feedback when the encoder rotates counterclockwise.

Factory default: [Clockwise].

Feedback type This option defines the feedback type. The following options are available:

• With direction info - the feedback provides direction information, for example an encoder.

• Without direction info - the feedback does not provide direction information (proximity switch configura-
tion).

Factory default: [With direction info].

Feedback filter This option defines the frequency used by the feedback filter for low-resolution encoder or proximity switch if
the resolution is low.

Range: 0.01–200 Hz (off).

Factory default: [200 Hz (off)].

Zero speed tim-
er

This option allows the speed to be below 120 RPM when SLS is active before STO is engaged.

Range: 0 s and 10000 s.

Factory default: [10].

8.7.3.5 Safe Input

The Safe input configuration tab details the input channel, settings, failure reaction, and reset functions that are mapped into the VLT®
Safety Option MCB 15x Series.
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Illustration 175: Safe Input Configuration Tab

The Safe input tab contains several sections and configuration possibilities.
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Table 22: Options for Safe Input

Option Description

DI1 safe function This option defines the safe function used by DI1. The following options are available:

• STO - Safe Torque Off is used as the safe functions by DI1.

• SS1-A - Safe Stop 1 A is used as the safe function by DI1.

• SS1-B - Safe Stop 1 B is used as the safe function by DI1.

• SLS-A - Safely Limited Speed A is used as the safe function by DI1.

• SLS-B - Safely Limited Speed B is used as the safe function by DI1.

• Disabled - The DI1 safe function is disabled.

Factory default: STO.

DI1 type This option defines the DI type used. The following options are available:

• NCNC - NCNC type is used.

• Antivalent - NO/NC (antivalent) type is used.

• NC - 1 NC input type is used.

DI1 restart behavior Restart of the MCB 15x configured the DI1 start behavior. The following options are available:

• Manual - The restart is performed manually.

• Automatic - The restart is performed automatically.

Factory default: Manual.

DI2 This option defines the safety function used by DI2. The following options are available:

• STO - Safe Torque Off is used as the safe functions by DI2.

• SS1-A - Safe Stop 1 A is used as the safe function by DI2.

• SS1-B - Safe Stop 1 B is used as the safe function by DI2.

• SLS-A - Safely Limited Speed A is used as the safe function by DI2.

• SLS-B - Safely Limited Speed B is used as the safe function by DI2.

• Disabled - The DI2 safe function is disabled.

Factory default: STO.

DI2 type The option defines the DI2 type used. The following options are available:

• NCNC - NCNC type is used.

• Antivalent - NO/NC (antivalent) type is used.

• NC - 1 NC input type is used.

DI2 restart behavior This option defines the DI2 restart behavior. The following options are available:

• Manual – The restart is performed manually.

• Automatic – The restart is performed automatically.

Factory default: Manual.

Table 23: Options for Input Settings

Option Description

DI1 discrepancy time This option defines the time for the DI1 signal discrepancy.

Range: 0–5000 ms.

Factory default: 10 ms.
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Option Description

DI1 stable signal time This option defines the time for the DI1 signal to become stable.

Range: 0–5000 ms.

Factory default: 10 ms.

DI2 discrepancy time This option defines the time for the DI2 signal discrepancy.

Range: 0–5000 ms.

Factory default: 10 ms.

DI2 stable signal time This option defines the time for the DI2 signal to become stable.

Range 0–5000 ms.

Factory default: 10 ms.

Table 24: Options for Failure Reaction

Option Description

External failure re-
action

This option defines the reaction that is executed if there is an external failure. The following options are avail-
able:

• STO - STO is executed.

• SS1-A - SS1-A is executed.

• SS1-B - SS1-B is executed.

Factory default: STO.

Table 25: Options for Reset Settings

Option Description

Reset source This option defines the source for the reset signal for safe plug-in for MCB 15x. The following options are available:

• Drive Reset - The source is a drive reset.

• Drive Safe Reset - The source is a safe drive reset.

• Safe Option DI2_A - The source is MCB 15x DI2_A.

Factory default: Drive Reset.

8.7.3.6 Safe Stop 1

The Safe Stop 1 tab allows setting specific scenarios for safe stopping of the drive using designated conditions.
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Illustration 176: Safe Stop 1 Tab

The Safe Stop 1 tab contains the following separated sections with the following configuration possibilities:

Table 26: Options for SS1-A

Option Description

Type This option defines the type for the safe stopping configuration. The following options are available:

• Delay - a delay is used to stop the drive safely.

• Ramp - a ramp is used to stop the drive safely.

Factory default: Delay.
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Option Description

Type: De-
lay

The following configuration options are available when the type is set to delay:

Delay time This option defines the amount of time that is used by the SS1 delay function to ramp the speed
down to 0 RPM.

Range: 0.1–3600 s.

Factory default: 1 s.

Ramp profile This option defines the ramp profile setting. The following options are available:

• Linear - a linear ramp is used for the delay.

• S-ramp const. time - a constant time ramp is used to stop the drive safely.

Factory default: Linear.

Delta time This option defines buffer time that is added to the delay time before activating STO.

Range: 0–99%.

S-ramp Ratio start This option is configurable only when S-ramp constant time is selected as the ramp profile. This
option defines the proportion of the total ramp-down time where the deceleration torque in-
creases. The greater the percentage value, the greater the jerk compensation achieved, and thus
the lower the torque jerks in the application.

Range: 1–50%.

Factory default: 50%.

S-ramp Ratio end This option is configurable only when S-ramp constant time is selected as the ramp profile. This
option defines the proportion of the total ramp-down time where the deceleration torque in-
creases. The greater the percentage value, the greater the jerk compensation achieved, and thus
the lower the torque jerks in the application.

Range: 1–50%.

Factory default: 50%.
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Option Description

Type:
Ramp

The following configuration options are available when the type is set to ramp:

Ramping set-up This option defines the ramping set-up used. The following options are available:

• Slope - a sloping ramp is used.

• Time - a time ramp is used.

Deceleration rate This option is configurable only when slope is selected for the ramping set-up. This option de-
fines the deceleration rate for the SS1 slope-based ramp style.

Range: 1–30000 RPM/s.

Factory default: 1500 RPM/s.

Ramp time This option is configurable only when time is selected for the ramping set-up. It defines the time
after which the safe plug-in for VLT® Safety Option MCB 15x Series engages the STO.

Delta V This option defines the tolerance between the calculated speed and the actual speed that the
safe plug-in for MCB 15x allows.

Range: 1–10000 RPM.

Factory default: 120 RPM.

Zero speed This option defines the speed at which safe plug-in for MCB 15x engages the STO.

Range: 1–600 RPM.

Factory default: 10 RPM.

Table 27: Options for SS1-B

Option Description

Type This option defines the type for the safe stopping configuration. The following options are available:

• Delay - a delay is used to stop the drive safely.

• Ramp - a ramp is used to stop the drive safely.

Factory default: Delay.
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Option Description

Type: De-
lay

The following configuration options are available when the type is set to delay:

Delay time This option defines the amount of time that is used by the SS1 delay function to ramp the speed
down to 0 RPM.

Range: 0.1–3600 s.

Factory default: 1 s.

Ramp profile This option defines the ramp profile setting. The following options are available:

• Linear - a linear ramp is used for the delay.

• S-ramp const. time - a constant time ramp is used to stop the drive safely.

Factory default: Linear.

Delta time This option defines buffer time that is added to the delay time before activating STO.

Range: 0–99%.

S-ramp Ratio start This option is configurable only when S-ramp constant time is selected as the ramp profile. This
option defines the proportion of the total ramp-down time where the deceleration torque in-
creases. The greater the percentage value, the greater the jerk compensation achieved, and thus
the lower the torque jerks in the application.

Range: 1–50%.

Factory default: 50%.

S-ramp Ratio end This option is configurable only when S-ramp constant time is selected as the ramp profile. This
option defines the proportion of the total ramp-down time where the deceleration torque in-
creases. The greater the percentage value, the greater the jerk compensation achieved, and thus
the lower the torque jerks in the application.

Range: 1–50%.

Factory default: 50%.

Plug-insOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 159Danfoss A/S © 2019.01



Option Description

Type:
Ramp

The following configuration options are available when the type is set to ramp:

Ramping set-up This option defines the ramping set-up used. The following options are available:

• Slope - a sloping ramp is used.

• Time - a time ramp is used.

Deceleration rate This option is configurable only when slope is selected for the ramping set-up. This option de-
fines the deceleration rate for the SS1 slope-based ramp style.

Range: 1–30000 RPM/s.

Factory default: 1500 RPM/s.

Ramp time This option is configurable only when time is selected for the ramping set-up. It defines the time
after which the safe plug-in for VLT® Safety Option MCB 15x Series engages the STO.

Delta V This option defines the tolerance between the calculated speed and the actual speed that the
safe plug-in for MCB 15x allows.

Range: 1–10000 RPM.

Factory default: 120 RPM.

Zero speed This option defines the speed at which safe plug-in for MCB 15x engages the STO.

Range: 1–600 RPM.

Factory default: 10 RPM.

8.7.3.7 Safely Limited Speed

The Safely Limited Speed tab allows setting specific scenarios for safely limited speeds of the drives using designated conditions.
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Illustration 177: Safely Limited Speed Tab

The safely limited speed contains the following separated sections with the following configuration possibilities:

Table 28: Options for SLS-A

Option Description

SLS set-up This option defines the type of the safely limited speed set-up. The following options are available:

• SLS without ramp.

• SLS with ramp.

Ramp-down
time

This option is configurable only when the SLS with ramp is selected in SLS set-up. It defines the ramp-down time
for start ramp.

Range: 0.1–3600 s.

Factory default: 1 s.
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Option Description

Cutoff speed This option defines the speed at which the fail-safe reaction is activated. This setting should equal the value of
the speed limit parameter plus tolerance.

Range: 1–10000 RPM.

Speed limit This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit meas-
ured in RPM.

Fail-safe reac-
tion

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO - Safe Torque Off is used.

• SS1-A - Safe Stop 1-A is used.

• SS1-B - Safe Stop 1-B is used.

Table 29: Options for SLS-B

Option Description

SLS set-up This option defines the type of the safely limited speed set-up. The following options are available:

• SLS without ramp.

• SLS with ramp.

Ramp-down
time

This option is configurable only when the SLS with ramp is selected in SLS set-up. It defines the ramp-down time
for start ramp.

Range: 0.1–3600 s.

Factory default: 1 s.

Cutoff speed This option defines the speed at which the fail-safe reaction is activated. This setting should equal the value of
the speed limit parameter plus tolerance.

Range: 1–10000 RPM.

Speed limit This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit meas-
ured in RPM.

Fail-safe reac-
tion

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO - Safe Torque Off is used.

• SS1-A - Safe Stop 1-A is used.

• SS1-B - Safe Stop 1-B is used.

8.7.3.8 Safe Maximum Speed - SMS

N O T I C E
SOFTWARE VERSION

The SMS function is only available in drives with software version 8.31 or newer.
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Illustration 178: Identification of Drive Software Version

If a VLT® AutomationDrive FC 302 has the VLT® Sensorless Safety MCB 159 option installed, the Safe Maximum Speed function is
available. The MCB 159 offers safe speed monitoring and prevents continuously exceeding a defined speed value.

Use the SMS function to monitor machine speed. When maximum allowed speed is exceeded, STO is activated as fail-safe reaction. In
the Safe Maximum Speed tab, it is possible to enable or disable the SMS function and to set the cutoff speed in RPM.

Plug-insOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 163Danfoss A/S © 2019.01



e3
0b

u3
06

.1
0

Illustration 179: Safe Maximum Speed Configuration Tab

Table 30: Options for Safe Maximum Speed

Option Description

SMS enable The setting of this option selects whether or not the SMS function is enabled:

• Inactive - the SMS function is not enabled.

• Active - the SMS function is enabled.

SMS Cut off Speed Set at which RPM the SMS function should cut off the drive.

8.7.4 Configuration

Configure the safe plug-in in online mode (PC connected to drive) or in offline mode (no PC connected to drive). In both cases, enter
the required values in the configuration dialogs to configure the plug-in.

N O T I C E
Multiple value entry fields in the configuration tabs are accompanied by recommended value settings that appear below the
text field. The recommended values are generated dynamically based on the user input of related and dependent
configuration options. To apply a recommended value to a field, press the underlined Apply link as it appears below the desired
field.
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Offline configuration

When configuring the VLT® Safety Option MCB 15x Series in an offline project mode, the configuration is stored in the project. After
completing the configuration, connect to the PC and write to the drive.

N O T I C E
The LED status icons are not active in offline mode.

Online configuration

Changed settings within safe plug-in for MCB 15x are not applied before they are written to the device.

N O T I C E
If the safe plug-in for the MCB 15x interface is closed before the changes have been written to the drive, the changes are lost.

8.7.4.1 Configuring the Safe Plug-in Online

Procedure

1. Connect the safe plug-in for MCB 15x to the drive.

2. Click Write to drive to apply changed settings in the safe plug-in. Writing the values to the drive always updates the entire device
package and not just the changed value.

8.7.4.2 Dependencies

Multiple configurable safety parameters depend on other safety parameter values. The safe plug-in for VLT® Safety Option MCB 15x
Series features notification dialogs that inform about the possible consequences. It is then possible to verify the changes and either
accept or discard the change.
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Illustration 180: Dependencies Confirmation Dialog

When accepting the dependency dialog, both the change that caused the dependency dialog and all other configuration items listed
in the dependency dialog are applied.
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8.7.4.3 Advanced Configuration Parameters

In the configuration area, the parameters section is a table format value entry for all configuration settings intended for advanced
users.
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Illustration 181: Parameters Configuration Tab

N O T I C E
Prepare a complete list of all configuration items and their respective values before commissioning.

8.7.4.4 Parameter Lists

N O T I C E
Parameters ending with .0 are used for either SS1-A or SLS-A. Parameters ending with .1 are used for either SS1-B or SLS-B in the
parameter groups 42-4* SS1 and 42-5* SLS. For parameter group 42-2* Input, .0 refers to DI1 and .1 to DI2.
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Table 31: Complete List of Parameters for Configuring via the Safe Plug-in

Parame-
ter

Description Factory value

4200 Speed Deviation Timer -

The amount of time for which a speed diviation above 120 RPM between estimated and measured
speed is allowed.

10 ms

4201 Fast Ramp -

Use when fast ramping is needed with poor resolution of measured speed.

No

4210 Measured speed source – The source of the speed feedback. Safe option

4211 Encoder resolution – The resolution of the encoder connected to the safe plug-in for MCB 15x. 1024

4212 Encoder direction. Clockwise

4213 Gear ratio – The ratio between the motor speed and the encoder speed. 10.000

4214 Feedback type. With direction
info

4215 Feedback filter – The frequency of the feedback filter. 200.00

4216 Mounting Type - Location where the measured speed source is mounted. Motor shaft
mounted

4218 Zero speed timer – The timer for the zero speed activation. 10

4220.0 Safe function – The safe function selected. STO

4220.1 Safe function – The safe function selected. STO

4221.0 Type – The type of the safe input. NCNC

4221.1 Type – The type of the safe input. NCNC

4222.0 Discrepancy time – The time amount allowed for discrepancy. 10

4222.1 Discrepancy time – The amount of time allowed for discrepancy. 10

4223.0 Stable signal time – The amount of time for a stable signal. 10

4223.1 Stable signal time – The amount of time for a stable signal. 10

4224.0 Restart behavior – The restart behavior of the safe plug-in for MCB 15x, automatic or with user in-
put.

Manual

4224.1 Restart behavior – The restart behavior of the safe plug-in for MCB 15x, automatic or with user in-
put.

Manual

4230 External failure reaction – The safety function that is executed if there is an external failure. STO

4231 Reset source – The source for the reset signal. Drive reset

4233 Parameter set name – The title for the current safe plug-in for MCB 15x configuration. The maxi-
mum length of the parameter set name is 8 symbols.

–

4240.0 Type – Type of the safe stop function. Delay

4240.1 Type – Type of the safe stop function. Delay

4241.0 Ramp profile – The ramp profile that is either defined by the safe plug-in for MCB 15x or within the
drive itself.

Linear
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Parame-
ter

Description Factory value

4241.1 Ramp profile – The ramp profile that is either defined by the safe plug-in for MCB 15x or within the
drive itself.

Linear

4242.0 Delay time – The amount of time spent by the safe stop function to ramp the speed down to
0 RPM.

1.0

4242.1 Delay time – The amount of time spent by the safe stop function to ramp the speed down to
0 RPM.

1.0

4243.0 Delta T – The buffer time that is added to the delay time before activating STO. 2

4243.1 Delta T – The buffer time that is added to the delay time before activating STO. 2

4244.0 Deceleration rate – The deceleration rate for the safe stop slope ramp type. 1500

4244.1 Deceleration rate – The deceleration rate for the safe stop slope ramp type. 1500

4245.0 Delta V – The tolerance between the calculated and actual speeds allowed by the safe plug-in for
MCB 15x.

120

4245.1 Delta V – The tolerance between the calculated and actual speeds allowed by the safe plug-in for
MCB 15x.

120

4246.0 Zero speed – The zero speed limit that the safe plug-in for MCB 15x uses to engage STO. 10

4246.1 Zero speed – The zero speed limit that the safe plug-in for MCB 15x uses to engage STO. 10

4247.0 Ramp time – The ramp time that the safe plug-in for MCB 15x uses to engage STO. 1.0

4247.1 Ramp time – The ramp time that the safe plug-in for MCB 15x uses to engage STO. 1.0

4248.0 S-ramp Ratio at deceleration start – The proportion of the total ramp-down time wherein the de-
celeration torque increases. The greater the percentage value, the greater the jerk compensation
achieved.

50

4248.1 S-ramp Ratio at deceleration start – The proportion of the total ramp-down time wherein the de-
celeration torque increases. The greater the percentage value, the greater the jerk compensation
achieved.

50

4249.0 S-ramp Ratio at deceleration end – The proportion of the total ramp-down time wherein the decel-
eration torque decreases. The greater the percentage value, the greater the jerk compensation
achieved.

50

4249.1 S-ramp Ratio at deceleration end – The proportion of the total ramp-down time wherein the decel-
eration torque decreases. The greater the percentage value, the greater the jerk compensation
achieved.

50

4250.0 Cutoff speed – The speed at which the fail-safe reaction is engaged. –

4250.1 Cutoff speed – The speed at which the fail-safe reaction is engaged. –

4251.0 Speed limit – The maximum speed allowed when the safe limited-speed function is engaged. –

4251.1 Speed limit – The maximum speed allowed when the safe limited-speed function is engaged. –

4252.0 Fail-safe reaction – The safety function that is activated when the speed exceeds the limit set. STO

4252.1 Fail-safe reaction – The safety function that is activated when the speed exceeds the limit set. STO

4253.0 Start ramp – If the speed at the activation of safe limited speed is greater than the speed limit, the
function either ramps down to the speed limit (Yes value) or activates the STO (No value.).

No

4253.1 Start ramp – If the speed at the activation of safe limited speed is greater than the speed limit, the
function either ramps down to the speed limit (Yes value) or activates the STO (No value.).

No
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Parame-
ter

Description Factory value

4254.0 Ramp-down time – The ramp-down time for starting the ramp. 1.0

4254.1 Ramp-down time – The ramp-down time for starting the ramp. 1.0

4270 Activation - Use for activating or deactivating Safe Maximum Speed. Inactive

4271 Cut Off Speed - The maximum allowed speed. 1500 RPM
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8.7.5 Commissioning

Procedure

1. Configure a safe plug-in for VLT® Safety Option MCB 15x Series.

2. Click Write to drive to upload to the drive.

The status window opens.
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Illustration 182: Writing to Drive Status Window

3. Enter the password when the Confirm password dialog pops up (default password: 12345678).

For more information on changing password, refer to 8.7.6.3 Change Password.
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Illustration 183: Password Entry Dialog

4. Press OK to continue OR press Cancel to discard the process and perform a rollback.

N O T I C E
When writing to a device in blank state, the user is prompted to provide a new password for the device. Have the
appropriate default password available at hand.
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Drives The top section of the summary shows all drives
affected by the write procedure. If there are multiple
drives, press the drive titles in the window to update
parameters and CRC accordingly.

ID The parameter ID written.

New
values

The value of the parameter that was designated to
be written to the drive. This column must have the
same value as Received values. If not, an error is
shown.

CRC This section shows the CRC values that were generated
from the application side and the drive side. These
values must match. If not, an error is shown.

Parameters This section details all the updated parameters
that were written to the drive.

Name The name of the parameter written.

Received
values

The value that was received from the drive after
the update procedure. This column must have
the same value as New values. If not, an error is
shown.

Illustration 184: Configuration Approval Dialog and Summary

5. When the configuration approval pops up, review the included summary.

6. Click Approve to confirm the changes and close the dialog window, OR click Cancel to discard the process and perform a rollback.

When the configuration is approved, the commissioning report is generated and shown.
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Illustration 185: Commission Report Review, Save, and Print Dialog

7. Click Save to save the commission report in Rich Text Format.

8. Click Print to print the report.

9. When the commissioning process is complete, press [Reset] on the drive to reboot.

8.7.5.1 Commissioning Report

During the commission process, the commission report is generated based on a fixed template within the MCT 10 application. The
report contains all data written to the drive.

The report is generated during the write-to-drive procedure and the data is gathered at the moment the report is generated. This
report contains the functions that must be tested, see more details in VLT® Safety Option MCB 15x Installation Guide and in VLT® Safety
Option MCB 152 Operating Instructions.

The contents and structure of the commissioning report are as follows:

• General introduction - general information and details about the report itself.

• Commissioning configuration - details regarding the commissioned set-up and parameter configurations.

• Commissioning test - specific testing scenarios for the current set-up. This section also contains CRC check procedure descriptions.

8.7.6 Operation

The following sections describe how to use the diagnostics function, how to reset, and how to change password.
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8.7.6.1 Using the Diagnostics Function

Procedure

1. Open the Safe Plug-in for VLT® Safety Option MCB 15x Series plug-in interface in network online mode.

2. Click Administration in the upper section of the interface.

The Safe Plug-in for MCB 15x Administration Window opens.
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Illustration 186: Safe Plug-in for MCB 15x Administration Window

3. Enter the Safe Plug-in for MCB 15x password configured for the drive.

4. Click Download to download the Safe Plug-in for MCB 15x event log.

5. Select a location to save the log file. The log is presented in simple text file format.

8.7.6.2 Using the Reset Function

Context:

N O T I C E
Resetting the device restores factory settings and erases any customized configuration on the device. To ensure rollback
possibility, back up the customized configuration before resetting.
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Procedure

1. Open the safe plug-in for VLT® Safety Option MCB 15x Series plug-in interface in network online mode.

2. Click Administration in the upper section of the interface.

3. Click the Reset tab header to open the Reset tab.

The Reset Password window opens.
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Illustration 187: Reset Password Window

4. Tick Yes, I want to reset Safe Option Configuration in the Drive for the drive to continue.

5. Enter the master password configured for the drive to continue.

6. Click Reset to reset the drive password and configuration.

7. Press [Reset] on the drive to reboot.

8.7.6.3 Change Password

Context:

When working with the safe plug-in for VLT® Safety Option MCB 15x Series plug-in in network online mode, Change password is shown
in the information area of the plug-in interface.
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Illustration 188: Safe Plug-in for MCB 15x Password Changing Window

Procedure

1. Click Change password.

2. Enter the current password into the Current password field.

3. Enter the new password into the New password field. The password length must be exactly 8 characters. The password is case
sensitive.

4. Confirm the new desired password by entering it again into the Confirm new password field.

5. If necessary, select the option Confirm to all blank initial drives to apply the new password to all new drives in the network.

6. Click Cancel to discard the procedure.

8.8 Status Plug-in

The Status plug-in is an online plug-in that shows the digital status words, control words, and alarm words.
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Illustration 189: Selecting the Status Plug-in

The plug-in only shows the available parameters. For each control word and status word, it shows the value in hex, reference, and
control word profile. The plug-in shows all bits. Green LEDs indicate active bits (value = 1), while gray LEDs indicate inactive bits. The
highlighted text shows the meaning of the bit status.
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Illustration 190: Example of Bit Status for Control Word

An information symbol in the left column of the screen indicates that a parameter has extra information. See illustration 190 for an
example. Click the information symbol to get information about a bit.
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Illustration 191: Example of Bit Information
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Illustration 192: Example of Maintenance Word
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Illustration 193: Example of Digital Input

N O T I C E
When bit 6 is active, the signal on DI 37 is inactive, meaning that there is no signal present on the input.

Status plug-in used with fieldbusses

All fieldbusses supported by MCT 10 Set-up Software support the Status plug-in. While the plug-in is open, MCT 10 reads the visible
parameter constantly. This way, the plug-in updates automatically when values change.
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Loss of communication

If communication is lost, the plug-in turns yellow and sends a notification. The latest values are kept as they were before the
communication loss. When communication is recovered, the plug-in recovers automatically.

8.9 Drive Control Plug-in

The Drive Control plug-in is available for online drive in the following product series:

• VLT® HVAC Drive FC 102.

• VLT® AQUA Drive FC 202.

• VLT® AutomationDrive FC 301/FC 302.

The plug-in is supported by serial communication and USB.

For the plug-in to work, it is required to be connected to the drive that should be controlled.

To open the plug-in, select Drive control in the structure in the left window.

e3
0b

t9
61

.1
0

Illustration 194: Drive Control in Structure

A temporary page opens for accepting risks and configuring important parameters.
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Illustration 195: Risks to Accept

8.9.1 Launching the Drive Control Plug-in

Prerequisites:

To be able to launch the Drive Control plug-in, it is required to accept the risk.
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Procedure

1. Tick I accept the risks.

2. Click Launch Drive Control.
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Illustration 196: Launch Drive Control Button

The Drive Control window opens.
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Illustration 197: Drive Control Window
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8.9.2 Setting the Control Word

Context:

At launch, the control word is set to 0400 but is not yet sent to the drive.
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Procedure

1. Set the control word in 1 of 2 ways:

Use the checkboxes.
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Illustration 198: Checkboxes for Setting Control Word

Type the value directly in the Request in Hex field.
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Illustration 199: Type in the Value Directly

The control word is now set.
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Illustration 200: Control Word Set

8.9.3 Start Drive Control

Prerequisites:

The control word must be set before starting the drive control.

Procedure

1. Click Start control.

The plug-in starts sending the control word and then reads the status word.
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Illustration 201: Start Control Button
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The control word is sent cyclically until clicking Stop control or until communication fails. The control state bar runs while the
control word is being sent.
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Illustration 202: Control State Bar Running

After a successful reading of a status, a notification is sent.
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Illustration 203: Last Status Read Successfully

At loss of communication, the bits of the status view turn yellow, and an error appears.
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Illustration 204: Loss of Communication
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Illustration 205: Error at Loss of Communication

8.9.4 Changing Control Word Bits

Context:

Control word bits can be changed while the control word is being sent. While changing the control word, the values of Request in hex
and Current outgoing request differ.
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Illustration 206: Request in Hex
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Illustration 207: Values of Current Outgoing Request
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Procedure

1. Enter the new value of the control word.

2. Click Update outgoing request.
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Illustration 208: Update Outgoing Request Button

After clicking Update outgoing request, the values are the same.

e3
0b

t9
77

.1
0

Illustration 209: Values Aligned in Request in Hex and Current Outgoing Request

8.9.5 Changing the Reference

Procedure

1. Change the reference in 1 of 2 ways:

Enter the hex value directly in Request in hex.

Enter the value in either decimal or percentage.

Values out of range are shown in pink.
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Illustration 210: Value Out of Range

The Update outgoing request button is disabled until a valid value is set.
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8.9.6 Open Drive Control Plug-in

When the Drive Control plug-in is open, the bus is locked, and it is not possible to scan or change parameter values.

It is possible to create a scope folder in a project that allows monitoring of relevant parameters while changing the control word via
Drive Control.
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Illustration 211: Create Scope Folder in Project

Once the Drive Control plug-in is closed, the control word is restored to the value it had before starting the plug-in. Also other
parameters are only changed temporarily.

N O T I C E
Control word and other parameters used by Drive Control are written to flash instead of EEPROM. When power cycling the
drive, these values are restored to the values they had before the Drive Control was started. If Drive Control of MCT 10 Set-up
Software closes abnormally, the parameter restore process is not done. To restore the values after an abnormal shutdown,
power cycle the drive.

8.10 Decoder Plug-in

Use the Decoder plug-in for decoding Safe Option log files. The decoded log files are shown both inline (all information shown in 1
line) and as an overview of a selected line.
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8.10.1 Starting the Decoder Plug-in

Procedure

1. Click the Tools menu.

2. Select SafeOption Log Viewer.
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Illustration 212: Selecting the Plug-in

3. Click Browse to select a file.
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Illustration 213: View of the Log Visualizer

4. Click the arrow button to expand the log area or the explanation area.
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Illustration 214: Expanding the Views
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Illustration 215: Log File Shown in Log Visualizer

Files that require decoding have a 1-line explanation in the explanation area (right window). To get a better overview of a failure
description, select the failure to see an overview of the description at the bottom of the window.

Illustration 216: Failure Shown as Inline Text
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Illustration 217: Overview of Failure Description

8.11 Service Log

The Service Log plug-in is available offline. It enables reading from the drive in the right view of the MCT 10 screen.

Pressing Read from drive overwrites any log files that are already in the log.
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Illustration 218: Read from Drive Overwrites Log Files
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9 Support of VLT® Wireless Communication Panel LCP 103

9.1 Introduction

MCT 10 Set-up Software supports the VLT® Wireless Communication Panel LCP 103. There are 2 different approaches depending on the
MCT 10 version used.

9.1.1 Using LCP 103 with MCT 10 Set-up Software Basic Version

Procedure

1. Right-click the drive that has the LCP 103 plugged in.

2. Select Update WIFI LCP firmware.

3. In the dialog box, select a file (*.bin is already selected).
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Illustration 219: Dialog for Selecting *.bin Files

4. Press [OK].

When the procedure is completed, the writing starts and the progress is visible.
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Illustration 220: Progress Bar Showing While Writing to the Drive
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N O T I C E
If errors occur, they are shown in the Customizing drive dialog box. If writing is successful, the dialog box closes
automatically.

9.1.2 Using LCP 103 with MCT 10 Set-up Software Advanced Version

Context:

With the advanced version of the MCT 10 Set-up Software, the Drive File Manager Plug-in can be used for connecting the LCP 103.
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Procedure

1. In the offline drive, select Drive File System.

2. Right-click in the right window and select Import File from the context menu.
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3. In the dialog box, select binary files (*.bin).
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4. Select the correct binary file.

Selecting a wrong file issues an error message.
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After a successful file import, the Drive File System shows information about the file.

e3
0b

t8
76

.1
0

5. Click the Drive File Manager icon.
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6. Via the Drive File Manager, write the *.bin file to the drive.
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10 VLT® Software Customizer

10.1 Introduction

The VLT® Software Customizer is available from MCT 10 Set-up Software version 4.00. The tool enables customization of the drive by
modifying or creating unique splash screens, initial values, and SmartStart wizards.

The plug-in contains 3 independent features:

• SplashScreen: Add a custom logo that is shown during initialization of the drive. The SplashScreen supports:

- jpeg.

- png.

- bmp.

- gif.

• InitialValues: Define unique parameter default values based on application needs in a customer-specific initial values (CSIV) format.
Every time the drive is initialized, it starts with the custom values.

• SmartStart: Create custom SmartStart wizards that guide through predefined application steps, which simplifies the commissioning
process.

Furthermore, it is possible to write to the drive and test in the simulator. The Write to drive function writes files that have been created
or imported into VLT® Software Customizer. Test in simulator launches the LCP simulator for simulating a connection to a drive. In the
Settings menu, it is possible to show or hide the disclaimer.
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Write to drive
Test in
simulator

Settings

Illustration 226: Tool Tips for Navigation and Support
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Illustration 227: A Mouseover Highlights the Area Pointed at

When doing a mouseover on 1 of the 3 features, the feature is highlighted, and a button is available. Click the button to open the
functions currently available for the selected feature.

Illustration 228: Button for Opening Available Functions
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Illustration 229: Example of Available Options for a Feature

10.1.1 Activation Key

The VLT® Software Customizer is an advanced tool that requires an activation key. To obtain the activation key, contact the local
Danfoss representative.
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Illustration 230: Dialog Box for Entering the Activation Key

10.1.2 Disclaimer

When the activation key is active, a disclaimer appears.
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Illustration 231: Disclaimer

Click OK to make the disclaimer disappear until the next restart of MCT 10 Set-up Software.

To avoid seeing the disclaimer at each start-up, tick the Do not display again.
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10.1.2.1 Changing the Disclaimer Settings

Context:

The settings for the disclaimer can be set at a later point.

Procedure

1. Select Settings in the top menu.
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Tick and click OK to show the disclaimer at each start-up.

Remove the check mark and click OK not to show the disclaimer at each start-up.
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10.2 SplashScreen

Use the SplashScreen tool to create images to be shown on the LCP while the drive initializes.

Either create a splash screen from new, import an existing SplashScreen file, or import a picture.
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10.2.1 Creating a Project from Blank

Procedure

1. Select New from blank to open the editor with an empty project.
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Illustration 234: Empty Project in Editor

2. Use the different tools in the menu to create the drawing. Width increases/decreases brush line thickness, left mouse button is for
freehand line, right mouse button for straight lines.

Undo
Width of
brush Eraser

Continue
to save

Cancel
workflow

Paste
from
clip-
board

Redo Brush Clear Zoom of
LCP area

About
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Illustration 235: Drawing Tools

3. When finished, click Continue.

4. In the dialog box, enter a file name and click Finish. Clicking Back returns to the editor, clicking Cancel cancels saving of the file.
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Illustration 236: Dialog Box for Saving a SplashScreen Image
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10.2.2 Selecting from Library

Procedure

1. Click Select from Library to open an already saved SplashScreen file (*.spla).

Select from Library is also used for editing already saved SplashScreen files.

10.2.3 Import

The import function allows import of:

• jpeg.

• jpg.

• bmp.

• png.

• tif.

• gif.

• spla.

• splash.

At import, the picture resizes to fit the LCP. If the entire picture is not visible, set the threshold value of the imported image.

e3
0b

t8
93

.1
0

Illustration 237: SplashScreen with Original Threshold Value
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Illustration 238: SplashScreen Improved with Higher Threshold Values

The quality of the picture can be improved further by using the brush.
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Illustration 239: SplashScreen Improved with the Brush Tool

When the picture is saved, the SplashScreen is added into the VLT® Software Customizer project along with a date and time stamp. It is
possible to edit and save more SplashScreen files, but only 1 appears in the project.

e3
0b

t8
97

.1
0

Illustration 240: SplashScreen and Preview Added to Project

Adding a SplashScreen to the project, changes the menu to offer the functions in Illustration 19.14.
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Illustration 241: Functions in the SplashScreen Menu

10.3 LanguageChanger

The LanguageChanger enables editing or creating a language by translating group names, subgroup names, help texts, and parameter
names.

When there is no file in the project, the menu is the same as in SplashScreen.
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Illustration 242: Overview of the LanguageChanger Menu

10.3.1 New from Blank

Selecting New from Blank opens the editor.

The editor contains tooltips about the Base Dictionary and the Base Dictionary Function.
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Illustration 243: Tooltips in the Editor

Base Dictionary

Use the Base Dictionary for selecting which dictionary (LNG file) the LanguageChanger should load. For example, for translating into
Spanish, select Spanish in the Base Dictionary. The LanguageChanger then loads parameter names, help texts, ad other texts in
Spanish.

Base Dictionary Function

Use the Base Dictionary Function for defining if the LanguageChanger should prefill the translations with texts from the Base Dictionary.
If selecting Blanks fall back to base, the LanguageChanger leaves the translation field empty.
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Illustration 244: Example of Base Dictionary set to English
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Illustration 245: Example of Base Dictionary set to German

If selecting Prefill new dictionary from base, the LanguageChanger prefills the translation field with texts from the Base Dictionary.
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Illustration 246: Example of Prefilled Translation Field with English Base
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Illustration 247: Example of Prefilled Translation Field with German Base

After selecting Base Dictionary and Base Dictionary Function, and after pressing Start, the LanguageChanger opens.
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Left view with parameters
          Original texts

Right view with texts that can be modified/translated
                                       New dictionary

Illustration 248: Overview of the LanguageChanger

N O T I C E
Language name on LCP comes from Base Dictionary. The name English is reserved for Danfoss. The name can be changed, for
example to English_Australia. This name is then shown in the LCP.
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Illustration 249: Language Name on LCP
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Illustration 250: Language Name Shown on the LCP

Once Language Name on LCP is set, it is possible to start modifying and translating.

N O T I C E
Not all parameters can be modified/translated. Parameters shown are the ones that can be modified or translated.

If clicking Cancel, a dialog appears.
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Illustration 251: Cancel Dialog

Clicking OK closes the LanguageChanger without saving any changes.

Clicking Back goes back to the LanguageChanger editor.

When editing is done, press Continue and assign a name to the new dictionary file.
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Illustration 253: LanguageChanger Project Name

The name is for the specific LanguageChanger project and is shown on the dashboard.
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Illustration 254: LanguageChanger Dashboard with Project Name

10.3.2 Search Filter

To easily find parameter names or texts to be translated, click the Search filter button.
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Illustration 255: Search Filter

Select to search in:

• Original texts and new dictionary,

• Original texts only, or

• New dictionary only.

For example, searching for motor power only shows the parameters that contain motor power in the name or in the help text.
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Illustration 256: Search Result for Motor Power

10.3.3 Advanced Settings

Advanced settings contains tooltips for each possible setting and is helpful at the creation of dictionary.
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Illustration 257: Overview of the Advanced Settings
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Illustration 258: Tooltip Example

10.3.4 Audit

Clicking Audit accepts the original text as it is and marks it completed without modifications or translations.

10.3.5 Markings

To visualize the progress of translation or creation of a dictionary, LanguageChanger shows different markups.

Text has not been modified or translated.

Text has been modified or translated.

Text has been accepted as is via the Audit function.

If Markings ignore audit is selected in the advanced settings, the marking only shows modified texts. All other texts are shown as

10.4 InitialValues

Use InitialValues to create CSIV files. Without a CSIV file, all parameters are reset to default values during initialization of the drive. With
a CSIV file, parameter values are initialized with the values defined in the CSIV file.
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Illustration 262: InitialValues Menu
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10.4.1 Creating a Project from Blank

Procedure

1. Select New from Blank to open an empty project in the editor.
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Illustration 263: Example of Empty Project

2. To add parameters, double-click in a parameter and change a value. For example, add German to the CSIV.
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Illustration 264: Setting a Value for the CSIV File

3. Click OK to add the value to the CSIV file.
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Illustration 265: Value Added to CSIV File
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Alternatively, use filters to easily find parameters to add to the CSIV file. Search by the parameter name or ID.
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Illustration 266: Example of Using Filters for Finding Parameters

To import a parameter available in the offline MCT 10 Setup Software project, click Apply project values.

Illustration 267: Apply Project Values Button
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10.4.2 Removing Parameters

Procedure

1. Select the parameter to be removed.

2. Click Reset selected parameter values to default.
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Illustration 268: Removing a Parameter

N O T I C E
When resetting a parameter, other parameters may disappear from the CSIV file or change their values due to
dependencies.

10.4.3 Saving the CSIV File

Prerequisites:

All values must be entered in the Initial Values editor before saving the CSIV file.

Procedure

1. Click Continue.

2. In the dialog box, enter a file name.
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3. Click Finish.

Clicking Back returns to the editor, clicking Cancel cancels saving of the CSIV file.
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When saving the CSIV file has completed, a preview of the file is shown in the project along with a date and time stamp.
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Illustration 270: Preview of CSIV File in Project

10.4.4 Validation of Parameters During Import

Parameters are validated during import of a CSIV file. Incompatible parameters cannot be imported and are highlighted.
Incompatibilities can be caused by, for example, missing parameters or a CSIV file created for a different product series.
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Illustration 271: Example of Incompatible Parameter

To copy the shown incompatibilities into Word or Notepad, click Copy incompatibilities.

To remove the incompatible parameters, click Remove incompatibilities.

It is possible to check the content of multiple CSIV files at import. Click Select other in the top left corner to open a Windows folder for
selecting other CSIV files.
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10.5 SmartStart

Use SmartStart to create set-up wizards that make commissioning of the drives easier and faster. The SmartStart wizard is a series of
steps ensuring accurate and efficient motor control.
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Illustration 272: SmartStart Menu in Project

N O T I C E
In SmartStart, it is not possible to import existing binary files (*.sas files). First, create a wizard model. This model is converted
into WDL scripting language, which is then compiled into a .sas binary file.

The SmartStart feature is based on the Model Drive Architecture® (MDA) standard by Object Management Group (OMG).

MDA

Illustration 273: MDA Logo
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MDA® is a set of guidelines for structuring specifications that are expressed as models.

MCT 10 Set-up Software allows OEMs to participate in the process of SAS engineering and specifying Smart Set-up behavior as model.
MDA defines 4 model layers, where the wizard designer operates on layer M1.

OMG

Illustration 274: OMG Logo

OMG® is an international non-profit technology standards consortium and is best known for standards distributed computing (CORBA)
and modeling (UML).

OMG develops standards for a wide range of technologies and industries but does not provide implementations of them.

10.5.1 Creating a Project from Blank

Context:

The SmartStart tool is organized in the following areas:

• Palette.

• Menu.

• Overview.

• Properties.

• Main/design area.
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Procedure

1. Select New from Blank to open an empty project in the editor.
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Illustration 275: Empty Project

2. Create the diagram in the main/design area.

10.5.1.1 Palette
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Add note, text, or an attachment
to the design

Zoom in - Left click
Zoom out - Shoft + left click
Zoom to selection - Drag

Select

Zoom out - Left click
Zoom in - Shift + left click

Illustration 276: Description of Icons in the Menu
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Add screen for revising 
a parameter

Merge multiple branches
into a single branch

Connect screens by
links to specify set-up flow

Connect the starting point
to the screen that should be
shown first

Add conditional branching
to set-up flow

Quit the set-up and
show drive status
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Illustration 277: Description of the Elements for Creating Diagrams

10.5.1.2 Menu

Redo Copy selection
as image

Undo

Delete selection

Save diagram
as image file
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Illustration 278: Description of the Elements for Creating Diagrams
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Select all, select all shapes,
sellect all connectors
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Illustration 279: Description of the Select Section in the Menu

Arrange all,
arrange selection

Auto
size

Select to have visible grid,
ruler, and if elements should
snap to grid or be placed
anywhere

About

Select all, 
select all shapes,
select all connectors

Different alignments
for the diagram:
Left, center, right,
up, middle, bottom

Shows or hides
connector labels

Different
types of zoom

Show key assist
(Ctrl+shift+L)
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Illustration 280: Description of Icons the Menu

10.5.1.3 Overview

The overview section gives an overview of the diagram as it starts to grow. The overview makes it easier to navigate.
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Illustration 281: Example of Diagram Shown in the Main/Design Area and in the Overview

10.5.1.4 Properties

The Properties view shows the property of a selected element in a diagram.
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Illustration 282: Example of Properties for Parameter (Screen)
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Illustration 283: Example of Properties for Link

10.5.2 Create Diagram

Create a diagram in any of 3 ways:

• Drag and drop the element into the Design area.

• Select an element by clicking it and then click in the Design area where the element should be placed.

• Leave the mouse cursor for 1 s on the Design area and small elements appear. Then select the needed element.
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Illustration 284: Elements for Creating Diagrams

N O T I C E
It is only possible to have 1 starting point. Once a starting point is inserted in the diagram, the element is grayed out in the
element list.
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10.5.3 Create Parameter Screen

After selecting or dropping a parameter screen into a diagram, a Create parameter screen dialog appears.
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Illustration 286: Create Parameter Screen Dialog

10.5.3.1 Filter

Filter parameters by typing the parameter name or ID.
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Illustration 287: Example of Filtering

Filtering the 1st parameter that matches the search and the groups and subgroups where the match is available.

While creating Parameter Screen, it is possible to filter choice lists and index parameters available in the wizard. Make the selection from
Valid choices.
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Illustration 288: Example Showing Available Languages

For index parameters, an index filter dialog box is shown. By default, all possible indices are selected. Use "-" for a range of filters, or use
"," for selecting individual indices. It is also possible to combine the selections.
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Illustration 289: Example of Index Parameter with Index Filter
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Illustration 290: Example of Individual Selection
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Illustration 291: Example of Combined Selection
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Illustration 292: Error Message when Filter is Wrong

N O T I C E
When the filter is wrong, it is not possible to click OK until the error has been corrected.

10.5.3.2 Customize Parameter Display Name

Parameter names can be customized and shown in the wizard. Type the new parameter name in the field Parameter display name.
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Illustration 293: Example of a Customized Parameter Name
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Illustration 294: Customized Parameter Name Shown in the LCP
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Illustration 295: Example of Customized String Shown in the LCP

A customized name is shown in the diagram and in Properties.

Illustration 296: Customized Name Shown in the Diagram
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Illustration 297: Customized Name Shown in Properties

10.5.3.3 Help Text

It is possible to define help texts for the parameter screens. The maximum character number for a help text is 511. To show a help text,
press the [Info] key on the LCP.
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Illustration 298: Example of Help Text
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Illustration 299: Help Text Shown in LCP After Pressing Info

10.5.4 Link Screens

Link between screens can be created in 2 ways:

• Select the Link icon from the palette.

• Use connectors to link elements.
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10.5.4.1 Linking via the Palette

Procedure

1. Drag the Link icon and drop it on the element to link from.

Drag down to the element to link to.
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Illustration 300: Link from the Palette

10.5.4.2 Linking via Connectors

Procedure

1. Select the elements to connect (leave the cursor over the element for connectors to appear).
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2. When the connector is shown, drag and drop it on the element to connect to.

When the connection is established, an arrow is shown and a label is added.
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Illustration 302: Established Connections with Label Added

Double-clicking the link opens the link properties. Use the link properties to add action scripts.
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Illustration 303: Link Properties

10.5.4.3 Action Scripts

Action scripts are for advanced users. Knowledge of the expected format is required.

Use the scripting assistant to create an action script for parameter initialization in any place where parameters are selected from a list.

Example

• Initialize parameters: P=value.

• Comments: Comments start with ";".
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Illustration 304: Example of Action Script

The action script is added to the diagram as a label.
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Illustration 305: Action Script Added to Diagram as Label

10.5.5 Branching

Context:

Use branching for having 1 point with several options. Each point has a guard condition that must be fulfilled for that option to be
selected. Click [TODO] to specify the guard condition.
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Illustration 306: Click [TODO]
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Illustration 307: Window for Defining Guard Conditions

The scripting assistant for guard conditions opens a dialog.
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Procedure

1. Select the parameter number.

2. Select the comparison operator.
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3. Select value.
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Illustration 309: Example of the Guard Scripting Assistant

Example:
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Illustration 310: Example of Branching with 2 Options
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Illustration 311: Example of Branching with 4 Options

10.5.6 Junction

Junction is used for chaining multiple transitions. A single junction can have 1 or more incoming transitions.
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Illustration 312: Example of Junction with Several Transitions

10.6 Writing to Drive

N O T I C E
TURN OFF THE DRIVE

Writing to drive puts the drive in test monitor mode. This is a special mode where it is possible to write files to flash the file
system. It is important to turn off the drive.

Writing to drive writes files from the VLT® Software Customizer.

If a file is already in the drive, it is overwritten by the new file.

10.6.1 Preserve Original vs. Wipe Original

Write to drive writes all files. If a feature does not contain any files, select either to keep the original file in the drive, or to delete it (Wipe
Original). By default, Preserve Original is selected. To change this setting, select it from the menu of the given feature.
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Illustration 313: Menu for SplashScreen

Changing from Preserve Original to Wipe Original issues a notification.
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Illustration 314: Notification when Changing Setting

After clicking [OK], the new setting is shown in the project.
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Illustration 315: New Setting Shown in Project

The settings are individual for each feature. If a feature has a file in the project, this setting is irrelevant and therefore grayed out.
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Illustration 316: Example of Grayed-out Setting

N O T I C E
To make back-up of files in the file system, use the Drive File System and the Drive File Manager.

10.6.1.1 Removing Files

Procedure

1. Select Remove from the given feature menu in the project.
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Illustration 317: Removing a File

10.7 Testing in Simulator

Use the simulator to test created files without being connected to a real drive and a real LCP. The simulator is an app that emulates LCP
behavior.
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Illustration 318: Select Test in Simulator in the Top Menu

Each drive series and each software version have different simulators.

If the simulator is not available when selecting Test in Simulator, a message is shown.
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Illustration 319: Warning Message - Simulator is not Installed

If the simulator is not available, contact a local Danfoss representative who can provide a zip file.
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10.7.1 Installing the Simulator

Procedure

1. Save the zip file locally on a PC.

Open the Tools menu in MCT 10 Set-up Software.

Select Update VLT Software Customizer support....
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Illustration 320: Selecting the Update VLT Software Customizer Support
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Example:
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Illustration 321: LCP Simulator
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11 Tool Calling Interface (TCI)

11.1 Introduction

The TCI is an interface between the programming tool (TIA/Step 7) for the PLC and the MCT 10 Set-up Software and it supports fieldbus
communication over network boundaries.

The TCI is available in the MCT 10 Set-up Software from version 4.20.

When installing the MCT 10, a program interface description (PID) file is created. This file acts as an interface between the TIA portal
and MCT 10. When MCT 10 is opened via the PLC, information about the drive and the parameter database are placed in a temporary
parameter (TPF) file.

Benefits

• Data is inside the programming file of the PLC.

• There is no risk of selecting the wrong MCT 10 project file.

• Exact match between the controller hardware configuration and MCT 10.

• The PLC calls MCT 10.

• Reduction of faults.

11.2 Installing the GSD/GSDML File

Context:

The GSD/GSDML file is required for the TCI interface to work. Danfoss provides the file.
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Procedure

1. Unzip the file.

2. Open the TIA portal.

3. Click the Options menu.

4. Click Manage.

5. Select the file and install it.
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Illustration 322: Installing the GSD/GSDML File

11.3 Creating a Project in TIA

Prerequisites:

The following files must be installed before creating projects:

• TIA Portal tool version 14 or higher, or Step 7 version 5.6 or higher.

• VLT® Motion Control Tool MCT 10 version 4.20 or higher.

• GSD/GSDML file provided by Danfoss.
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Procedure

1. Click Create project.

2. Expand the project in the project tree.

3. Click Devices & Networks.

4. Click Add new device.

5. Select the PLC.
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Illustration 323: Add New Device

11.4 Use Cases

11.4.1 Doing the Initial Connection

Prerequisites:

The PLC must be added before the initial connection can be established.

Tool Calling Interface (TCI)Operating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 241Danfoss A/S © 2019.01



Procedure

1. Click the Network icon at the top left corner of the right view.

2. Enter Danfoss in the search field.

The GSD file appears.

3. Build the drive network in the PLC via drag and drop.
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Illustration 324: Initial Connection

11.4.2 Configuring the TCI

Prerequisites:

The PLC must be programmed before starting the configuration.
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Procedure

1. Right-click the drive icon and start the device tool.

A dialog box shows for opening Danfoss Set-up Software.
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Illustration 325: Start Device Tool
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Illustration 326: Configuration

2. For online network: Select the network, for example TCI_Profinet.

The tool scans drives which are mapped to the TCI interface. A drive appears if it is connected to the PLC.

3. For offline project: Identify all drives in offline mode.

This step is applicable for creating a project with drives that are not physically connected.
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Illustration 327: Set Drive Manually

Once the MCT 10 parameters are configured and the tool is closed without saving the MCT 10 project, data goes to the TIA portal
and is saved as a TIA project.

When opening the drive from TIA, MCT 10 opens with the saved data and appears in MCT 10.
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12 SyncPos

12.1 SyncPos Handling

The VLT® 5000 and VLT® 5000 FLUX series have a SyncPos application option, which consists of a print card with a processor. For
detailed information, refer to Programmable SyncPos Motion Controller Operating Instructions.

MCT 10 Set-up Software can directly modify, read from, and write to SyncPos files. SyncPos files are stored within the MCT 10 Set-up
Software files and do not require separate handling.

When a VLT® 5000 has a SyncPos option installed, the MCT 10 Set-up Software shows 2 icons after the drive has been selected:

• An All parameters folder icon.

• A separate SyncPos icon.

Parameter group 7-** Controllers is incorporated under All Parameters and applies to SyncPos.

N O T I C E
MCT 10 Set-up Software does not fully support the SyncPos application versions 1.xx and 2.xx. The SyncPos folder is available
due to the lack of functionality in these initial versions.

12.2 Programs and Configuration File

The SyncPos program consists of 2 main parts:

• Configuration file (*.cnf).

• Program files (*.m).

A configuration file consists of a series of SyncPos parameters which can be programmed. MCT 10 Set-up Software allows importing,
exporting, and setting up SyncPos configuration files.

12.2.1 Programs

Programs can be inserted in the MCT 10 Set-up Software Project folder. When a new SyncPos program is selected, an untitled program
is inserted in the SyncPos folder. The program can be edited, written, and exported as in the standalone SyncPos program. If a SyncPos
program exists, it can be imported into the MCT 10 Set-up Software project.
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12.2.2 Viewing the Configuration File

Procedure

1. Select Configuration to view the drive configuration file in the right view of the screen.

2. To change the SyncPos settings, select the relevant drive in the right view to open a new editor (Cam Editor).

Refer to the Programmable SyncPos Motion Controller Operating Instructions for details on using the editor.

3. Change the settings.

4. Select Compile (in Settings in the main menu) or Exit Program (in File in the main menu).

5. When selecting Exit Program, select Read or Write.

The Confirm SyncPos write (or read) window pops up with 2 options for saving the SyncPos card.

6. Select the wanted option and select Yes or No.

When selecting Yes, the information is written to the drive.

N O T I C E
If Write to Drive is selected at the root of the drive, the MCT 10 Set-up Software also writes the SyncPos files to the SyncPos
options. This can lead to an unattended stop of the SyncPos card.

12.2.3 Importing and Exporting a Configuration File

Context:

This procedure describes how to import a configuration file to a SyncPos card. Exporting a file is done in the same way, but select
Export instead of Import.
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Procedure

1. Click the configuration file shown in the right view.
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Illustration 328: Import Configuration File
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Illustration 329: Import Configuration File

2. Select a configuration file for import from the computer directory.

3. Select the desired file and click Open to import the file to the Configuration folder.
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12.2.4 Editing and Saving a Configuration File

Procedure

1. Select the configuration file to view and edit.

The configuration editor opens.

2. Make the required changes to the configuration file.

3. Close the SyncPos application.

The SyncPos Application Closed dialog appears.
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Illustration 330: SyncPos Application Closed

4. Select

Read to save changes to the MCT 10 Set-up Software.

Write to save changes to the drive.

Reading or writing can take some time.
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12.2.5 Importing Program Files

Procedure

1. Click a program shown in the right view.
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Illustration 331: Import Program to SyncPos Card

2. Browse the computer to find the program to import.
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Illustration 332: Browse
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3. Select the wanted program.

4. Click Open to import the program in the Programs folder.

The import is now complete.

12.2.6 Setting a Program to Auto Start

Context:

If more than 1 program is stored in the Programs folder, it is possible to set 1 of them to start automatically when the device is turned
on.

Procedure

1. Select the start-up program in the right view of the screen.

2. Right-click and select Set As Auto Start.
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Illustration 333: Auto Start

The program selected is then indicated with Yes in the Auto Start column.

12.2.7 Editing Source Code

Context:

For detailed information about the source code, refer to Programmable SyncPos Motion Controller Operating Instructions. To view or
edit the source code, follow this procedure:
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Procedure

1. Double-click Program in the right view.
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Illustration 334: View/Edit Source Code

A range of editing operations are possible, described in detail in the Programmable SyncPos Motion Controller Operating
Instructions.

12.2.8 Saving and Exiting Program

Context:

When editing a configuration file, a SyncPos Application Closed dialog box pops up. Select Read or Write according to the instructions in
the box.

N O T I C E
If there are programs in the SyncPos card, they are deleted without further warning.
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Illustration 335: Confirm SyncPos Write

Procedure

1. Select File⇒Save in the menu bar to save the changes to the program file opened from the MCT 10 Set-up Software project.

2. Select File⇒Exit program in the menu bar to exit SyncPos.
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Illustration 336: Exit Program

12.3 SyncPos Read From Drive

Context:

Parameters and SyncPos files can be read from a drive to a project.
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Procedure

1. Right-click the root drive.

2. Select Read from Drive.
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Illustration 337: SyncPos Read From Drive

N O T I C E
Files in the project can be permanently lost as files of the same name are overwritten:
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Illustration 338: Files Overwritten

3. Select Yes to start reading and saving the configuration files and programs from the drive to the project.

12.4 SyncPos Write to Drive

Context:

All parameters and SyncPos files can be written to a drive.
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Procedure

1. Right-click the root drive.

2. Select Write to Drive.
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Illustration 339: Write to Drive

N O T I C E
Use this feature with caution. If incorrectly used, files on the drive can be permanently lost. The following warning
appears, explaining that files of the same name are overwritten:
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Illustration 340: Warning Files Overwritten

3. Select the required settings.

4. Select Yes to start writing.

SyncPosOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466254 | Danfoss A/S © 2019.01



For the above settings, the existing programs are deleted. Then the SyncPos program source files are written to the drive. Once the
write is complete, check the contents of the Network folder to confirm that the write to drive was successful.
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13 Troubleshooting

13.1 Save Error Dialog

When an error dialog appears on the screen, MCT 10 Set-up Software can save the error to a text file to record the error message for
later reference, for example to obtain help from support. Within the error dialog window, select Save As to record the error message as
a text file with free choice of file name and location.

For example, when scanning the network for drives, an error dialog appears, showing the drives which are not detected.
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Illustration 341: Drives not Detected

To store the error log, select Save As.
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Illustration 342: Store Error Log

13.2 Common Problems and Solutions

13.2.1 Changes are not Saved to PC

Check that changes made in the Network folder have been copied to the Project folder and then saved to a hard disk. Changes made in
the Network folder are implemented in the field device only and are not automatically saved to a PC.

13.2.2 Error Message While Installing MCT 10 Set-up Software

A message such as MCT 10 SET-UP SOFTWARE ERROR OPENING FC DRIVER may occur, if there is another PC program installed using
the same COM port of the PC. Such a program could be a PLC programming tool, palm pilot driver, or cellular phone driver. Investigate
whether other programs use the same COM port. If so, ensure that the other PC tool does not lock or reserve the COM port.

13.2.3 Error Message Communication Failed

Sporadic communication errors

This type of communication error typically occurs when cables are inadequately shielded, in which case EMC noise can affect the
communication. Check that the cables are installed according to the guidelines in the operating guide for the drive.
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The communication error is permanent

This type of communication error is typically due to an error in network configuration. Check that the network configuration is in
accordance with the drive operating guide.

Communication failed

The Communication failed error message appears in the status bar.
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Illustration 343: Error Message: Communication Failed

13.2.4 Communication Errors

If an erroneous/illegal action has been attempted, an error highlight appears in the status bar at the bottom of the MCT 10 Set-up
Software window.

When a communication error occurs, the status bar at the bottom of the MCT 10 Set-up Software window is highlighted and shows a
Communication failed error message.
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Illustration 344: Error Message: Communication Failed

When no communication error has occurred, the same window appears as:

TroubleshootingOperating Guide  | VLT® Motion Control Tool MCT 10

AQ283728700891en-000101 / 130R0466 | 259Danfoss A/S © 2019.01



e3
0b

t6
03

.1
1

Illustration 345: Communication OK

Communication errors typically occur due to inadequate shielding of cables, that is the cable is not installed in accordance with the
installation instructions.

13.2.5 Help

Select Help⇒Help in the main menu. A help file opens and shows the MCT 10 Set-up Software manual in .pdf format. Acrobat Reader
software is required to open the manual. It can be downloaded free of charge at www.adobe.com.

13.3 Safe Plug-in

This section contains common troubleshooting and descriptions of known errors.

13.3.1 Troubleshooting Communication Errors

During commission, the communication between MCT 10 Set-up Software and the drive can fail. Failed communication issues an error
message.

Confirm the status of the communication devices and the drive and the status of the drive to guarantee proper communication.

13.3.2 Troubleshooting CRC Errors

CRC errors can occur during the write-to-drive procedure. If a CRC error occurs, try to write to the drive again.
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When the CRC errors persist, verify the integrity of the devices and communication.

13.3.3 Warnings and Alarms

N O T I C E
The errors are listed numerically.

Table 32: LED Indications, Errors 1–68

Error
num-
ber

Descrip-
tion

LED indicators

LED1 LED2 LED4

Internal
failure

Reason Action Green
con-
stant

1 Diagnostic
in pro-
gress

Status of LED 1 and LED2 de-
pends on safety sub-function
state assigned to DI1 and DI2.

Green
con-
stant

67 Int Fail tol-
erance er-
ror excee-
ded: Reac-
tion STO

• Check that data for feed-
back (PPR., type of feed-
back, and gear ratio) is en-
tered correctly.

• Direction of feedback is
wrong.

• Due to use of feedback fil-
ter the dynamic of the sys-
tem does not match with
dynamic of feedback filter
(parameter 42-15 Feedback
Filter). System is ramping
too fast.

• Feedback signals are not
received at all.

• No proper shielding of
feedback cables.

• Make a recustomization
with correct data if nee-
ded.

• Set parameter 42-12 En-
coder Direction to the op-
posite value.

• Decrease the ramping
time on the drive.

• Try to run the system at,
for example, 60 RPM. If er-
ror 99, Int Fail Feedback er-
ror occurs, this is the rea-
son.

• Improve shielding of
feedback cables and mo-
tor cables.

Red
con-
stant

68 Int fail
Speed lim-
it SS1a
Ramp: Re-
action STO

• The value of Delta V is too
small. For closed-loop sys-
tem, it must often be larg-
er than the recommended
value.

• Due to use of feedback fil-
ter the dynamic of the sys-
tem does not match with
dynamic of feedback filter
(parameter 42-15 Feedback
Filter).

• Load change takes place
during ramping.

• If running in closed loop,
try to adjust PID setting
and if needed increase
SS1 ramping time.

• Try to increase parameter
42-15 Feedback Filter, but
this might cause error 67,
Int Fail tolerance error ex-
ceeded: Reaction STO to
occur.

• Otherwise increase pa-
rameter 42-45 Delta V.

Red
con-
stant
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Table 33: LED Indications, Errors 69–72

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Reason Action Green
con-
stant

69 Int fail Speed
limit SS1b
Ramp: Reac-
tion STO

See 68. See 68. Status of LED 1 and LED 2 depends
on safety sub-function state assigned
to DI1 and DI2.

Red
con-
stant

70 Int fail speed
limit SLSa:
Reaction STO

Happens during
ramping to SLS limit,
see 68.

Happens during
speed below SLS lim-
it:

• If speed is above
cut-off speed at
activation point
and parameter
42-53 Start Ramp
is set to No, this
error occurs.

• Noise on the feed-
back signal (incl.
quantization
noise) is larger
than expected.

• Load change
takes place, do as
in above point.

• Change parameter
42-53 Start Ramp to Yes
and set parameter
42-54 Ramp Down Time
accordingly.

• Increase parameter
42-50 Cut Off Speed or
decrease parameter
42-51 Speed Limit to get
a larger tolerance.

Red
con-
stant

71 Int fail speed
limit SLSb:
Reaction STO

See 70. See 70. Red
con-
stant

72 Internal fail-
ure MCB
150/151

• First, power cycle the
drive or restart the safe-
ty option via parameter
42-90 Restart Safe Op-
tion. Second, try to
make a general reset of
the safety option with
the Administration but-
ton (safety option goes
back to blank initial
state).

• If the problem persists,
contact Danfoss.

Red
con-
stant
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Table 34: LED Indications, Errors 73–77

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Reason Action Green
con-
stant

73 Internal fail-
ure MCB
150/151

• First, power cycle the drive or
restart the safety option via
parameter 42-90 Restart Safe
Option.

• If the problem persists, con-
tact Danfoss.

Status of LED 1 and LED 2 depends on
safety sub-function state assigned to
DI1 and DI2.

Red
con-
stant

74 Internal fail-
ure MCB
150/151

• First, power cycle the drive or
restart the safety option via
parameter 42-90 Restart Safe
Option.

• If the problem persists, con-
tact Danfoss.

Red
con-
stant

75 Int Fail DI2 in
PUST: Reac-
tion STO

• Safety in-
put con-
nected to
DI2 has ille-
gal signal
level.

• Sensor is
broken.

• Check that the configuration
of DI2 parameter 42-21 Type is
set correctly or that the con-
nected sensor is installed ac-
cording to specification.

• Extend discrepancy time on
the safe input tab in the MCT
10 Safe Plug-in via parameter
14-22 Operation Mode.

Red
con-
stant

76 Int Fail DI1 in
PUST: Reac-
tion STO

• Safety in-
put con-
nected to
DI1 has ille-
gal signal
level.

• Sensor is
broken.

• Check that the configuration
of DI1 parameter 42-21 Type,
sub-index [0], is set correctly
or that the connected sensor
is installed according to spec-
ification.

• Extend discrepancy time on
the safe input tab in the MCT
10 Safe Plug-in via parameter
14-22 Operation Mode.

Red
con-
stant

77 Int Fail fail-
safe data
CRC mis-
match: Reac-
tion STO

The CRC of the
safety option
does not match
the stored CRC
value on the
drive.

Configure the safety option with
MCT 10 Safe Plug-in or by CRC se-
lect/LCP copy.

Red
con-
stant
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Table 35: LED Indications, Errors 78–85

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Rea-
son

Action Green
constant

78 Internal fail-
ure safety op-
tion

• First, power cycle
the drive or restart
the safety option
via parameter 42-90
Restart Safe Option.

• If the problem per-
sists, contact Dan-
foss.

Status of LED 1 and LED 2 depends on safety sub-func-
tion state assigned to DI1 and DI2.

Red con-
stant

79 Internal fail-
ure safety op-
tion

Contact Danfoss. Red con-
stant

80 Internal fail-
ure safety op-
tion

Contact Danfoss. Red con-
stant

81 Internal fail-
ure safety op-
tion

• First, power cycle
the drive.

• If the problem per-
sists, contact Dan-
foss.

Red con-
stant

82 Internal fail-
ure safety op-
tion

• First, power cycle
the drive.

• If the problem per-
sists, contact Dan-
foss.

Red con-
stant

83 Internal fail-
ure safety op-
tion

• First, power cycle
the drive.

• If the problem per-
sists, contact Dan-
foss.

Red con-
stant

84 Internal fail-
ure safety op-
tion

• First, power cycle
the drive.

• If the problem per-
sists, contact Dan-
foss.

Red con-
stant

85 Internal fail-
ure safety op-
tion

• First, power cycle
the drive.

• If the problem per-
sists, contact Dan-
foss.

Red con-
stant
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Table 36: LED Indications, Errors 86–93

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Rea-
son

Action Green
constant

86 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Status of LED 1 and LED 2 depends on safety sub-
function state assigned to DI1 and DI2.

Red con-
stant

87 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Red con-
stant

88 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Red con-
stant

89 Internal fail-
ure safety op-
tion

• Perform a general re-
set of the safety option
with the Administra-
tion button.

• If the problem persists,
contact Danfoss.

Red con-
stant

90 Internal fail-
ure safety op-
tion

• Perform a general re-
set of the safety option
with the Administra-
tion button.

• If the problem persists,
contact Danfoss.

Red con-
stant

91 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Red con-
stant

92 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Red con-
stant

93 Internal fail-
ure safety op-
tion

• First, power cycle the
drive.

• If the problem persists,
contact Danfoss.

Red con-
stant
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Table 37: LED Indications, Errors 94–102

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Reason Action Green
con-
stant

94 Internal fail-
ure safety
option

• First, power cycle
the drive.

• If the problem
persists, contact
Danfoss.

Status of LED 1 and LED 2 depends on safety
sub-function state assigned to DI1 and DI2.

Red
con-
stant

95 Internal fail-
ure safety
option

• First, power cycle
the drive.

• If the problem
persists, contact
Danfoss.

Red
con-
stant

96 Internal fail-
ure safety
option

• First, power cycle
the drive.

• If the problem
persists, contact
Danfoss.

Red
con-
stant

97 Internal fail-
ure safety
option

Contact Danfoss. Red
con-
stant

98 Int fail inva-
lid customer
file version

Version of cus-
tomization file of
safety option stor-
ed in EEPROM
does not match
the customization
file supported by
the SW version of
safety option.

Do a new configura-
tion with MCT 10
Safe Plug-in, which
supports the SW ver-
sion of safety option.

99 Int Fail Feed-
back error

The connected
feedback source
does not give any
signal.

Check that the con-
nection is done ac-
cording to the speci-
fication or if the feed-
back source is bro-
ken.

Red

102 Int Fail
Speed Limit
SMS: Reac-
tion STO

• Speed is
above cut-off
speed.

• Noise on the
feedback sig-
nal (incl. quan-
tization noise)
is larger than
expected.

Check the value of
parameter 42-71 Cut
Off Speed.

Red
con-
stant
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Table 38: LED Indications, Errors 113–135

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal fail-
ure

Reason Action Green con-
stant

113 Ext Fail DI1:
Reaction STO

• Safety input
connected to
DI1 has illegal
signal level.

• Sensor is bro-
ken.

• Check that config-
uration of DI1 pa-
rameter 42-21 Type
is set correctly or
the connected
sensor is installed
according to the
specification.

Red constant. Status depends
on safety sub-
function state as-
signed to DI2.

Red flash-
ing, cycle
(on 500 ms,
off 500 ms)

114 Ext Fail DI2:
Reaction STO

• Safety input
connected to
DI2 has illegal
signal level.

• Sensor is bro-
ken.

• Check that config-
uration of DI2 pa-
rameter 42-21 Type
is set correctly or
the connected
sensor is installed
according to the
specification.

• Extend discrepan-
cy time on safe in-
put tab in MCT 10
Safe Plug-in pa-
rameter 14-22 Op-
eration Mode.

Status depends
on safety sub-
function state as-
signed to DI1.

Red constant. Red flash-
ing, cycle
(on 500 ms,
off 500 ms)

115 Ext Fail Prec
Thresh Timer
Elapsed: Reac-
tion STO

The drive has been
running below
120 RPM for more
than the time en-
tered in parameter
42-18 Zero Speed
Timer with safe
function SLS active.

Increase speed to
above 120 RPM.

Status of LED 1 and LED 2 depends on
safety sub-function state assigned to
DI1 and DI2.

Red flash-
ing, cycle
(on 500 ms,
off 500 ms)

116 Ext Fail SF acti-
vation Speed
Suspension:
Reaction STO

The drive has been
running below
120 RPM for more
that 1 year and a
safety sub-function
that needs speed
feedback is activa-
ted.

Increase speed to
above 120 RPM.

Red flash-
ing, cycle
(on 500 ms,
off 500 ms)

134 Int fail speed
limit SLSa: Re-
action SS1a

See 70. See 70. Red con-
stant

135 Int fail speed
limit SLSb: Re-
action SS1a

See 70. See 70. Red con-
stant
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Table 39: LED Indications, Errors 177–252

Error
num-
ber

Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action Green constant

177 Ext Fail DI1: Reaction
SS1a

See
113.

See 113. Red constant. Status depends on
safety sub-function
state assigned to DI2.

Red flashing, cy-
cle (on 500 ms, off
500 ms)

178 Ext Fail DI2: Reaction
SS1a

See
114.

See 114. Status depends on
safety sub-function
state assigned to DI1.

Red constant. Red flashing, cy-
cle (on 500 ms, off
500 ms)

179 Ext Fail Prec Thresh
Timer Elapsed: Reac-
tion SS1a

See
115.

See 115. Status of LED 1 and LED 2 depends on safety
sub-function state assigned to DI1 and DI2.

Red flashing, cy-
cle (on 500 ms, off
500 ms)

180 Ext Fail SF activation
Speed Suspension:
Reaction SS1a

See
116.

See 116. Red flashing, cy-
cle (on 500 ms, off
500 ms)

198 Int fail speed limit
SLSa: Reaction SS1b

See 70. See 70. Red constant

199 Int fail speed limit
SLSb: Reaction SS1b

See 70. See 70. Red constant

241 Ext Fail DI1: Reaction
SS1b

See
113.

See 113. Red constant. Status depends on
safety sub-function
state assigned to DI2.

Red flashing, cy-
cle (on 500 ms, off
500 ms)

242 Ext Fail DI2: Reaction
SS1b

See
114.

See 114. Status depends on
safety sub-function
state assigned to DI1.

Red constant. Red flashing, cy-
cle (on 500 ms, off
500 ms)

243 Ext Fail Prec Thresh
Timer Elapsed: Reac-
tion SS1b

See
115.

See 115. Red flashing, cy-
cle (on 500 ms, off
500 ms)

244 Ext Fail SF activation
Speed Suspension:
Reaction SS1b

See
116.

See 116. Red flashing, cy-
cle (on 500 ms, off
500 ms)

252 Internal failure safety
option

Power cy-
cle the
drive. If
the prob-
lem per-
sists, con-
tact Dan-
foss.

13.3.3.1 Safety Option Warning

A warning message notifies that an issue exists on the safety option. It is not handled as an internal or external failure. These messages
are defined to indicate that a manual user action is required.
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N O T I C E
At any possible failure or warning indicated from the safety option, the LCP shows warning, !Safe Option Failure [W252] at the
least.

13.3.3.2 Safety Option Reset Message

For some messages, the safety option requires an acknowledgement of an ongoing action or failure on the safety option. The safety
option uses Safe Option RESET as a Restart and Failure Acknowledgement.

Table 40: LCP Reset Messages

LCP message Description

e3
0b

d1
26

.1
1

S tatus

SO  Reset required!

!1(1)
0 R PM        None       0.00        KW

!Safe S top [W68]

In the following cases, the safety option requests a restart and failure acknowledgement signal:

• The safety option is in safety sub-function pending-state (remark: Occurs only if reset behav-
ior is set/configured to Manual).

• After a power cycle with a safety sub-function.

• In PUST (power up self-test), if an external failure occurred before power cycle.

• When an external failure occurred.

• When customization was aborted or completed.

• At the reception of a general reset (required after blank initial state or in the customization
state).

e3
0b

d1
27

.1
1

S tatus

SO in Self-test

!1(1)
0 R PM      None          0.00       KW

!Safe S top [W68]

The safety option indicates that it is in PUST State (Power Up Self Test).

• Ensure that no safe function is active after a power cycle.

e3
0b

d1
27

.1
1

S tatus

SO in Self-test

!1(1)
0 R PM      None          0.00       KW

!Safe S top [W68]

A safety sub-function is pending at the start-up, if the drive was powered down while a safety
function was active. It is also pending, when the drive was powered down while the safety option
has detected a failure during an active safety sub-function.

e3
0b

d1
29

.1
1

S tatus

  SafeOpt. initialised

!1(1)
0 R PM      None         0.00         KW

!Safe S top [W68]

The safety option requests a Restart and Failure Acknowledge signal, which is always required af-
ter a PUST and when a safety sub-function gets released and is configured to be confirmed that
the motor is able to run.
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LCP message Description

e3
0b

d1
30

.1
1

S tatus

  SO General Reset

!1(1)
0 R PM       None          0.00       KW

!Safe S top [W68]

Occurs only if general reset is performed from MCT 10. It is an indication to the user. The safety
option is set to blank initial state and safe parameters are set to default.

e3
0b

d1
31

.1
1

S tatus

SO Suspend-SpeedMon

!1(1)
0 R PM       None          0.00       KW

!Safe S top [W68]

Zero speed timer contains the remaining time until the fail prec thresh timer elapsed after the
monitoring time expires. The safety option signals Warning.

e3
0b

d1
32

.1
1

S tatus

SO Warning PUST

!1(1)
0 R PM      None           0.00       KW

!Safe S top [W68]

PUST warning has occurred. Warning cause: Expiry of PUST timer. Memory test required, perform
power cycle.

e3
0b

d1
33

.1
1

S tatus

SO Warning DI1

!1(1)
0 R PM     None          0.00         KW

!Safe S top [W68]

DI1 offline warning has occurred. Warning cause: Expiry of offline timer for DI1.

e3
0b

d1
34

.1
1

S tatus

SO Warning DI2

!1(1)
0 R PM       None          0.00       KW

!Safe S top [W68]

DI2 offline warning has occurred. Warning cause: Expiry of offline timer for DI2.

e3
0b

d1
31

.1
1

S tatus

SO Suspend-SpeedMon

!1(1)
0 R PM       None          0.00       KW

!Safe S top [W68]

Speed monitoring suspension warning has occurred. Warning cause: Suspension of speed moni-
toring for a certain duration.
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